# Table of Contents

ABOUT THIS MANUAL ................................................................................................................................. 7

1. INTRODUCTION ........................................................................................................................................ 7

2. CONVENTIONS AND TERMINOLOGY .................................................................................................... 7

2.1. CONVENTIONS ........................................................................................................................................ 7

2.1.1. References .......................................................................................................................................... 7

2.1.2. Notes ................................................................................................................................................... 7

2.1.3. Warnings ........................................................................................................................................... 7

2.1.4. Procedures ........................................................................................................................................ 7

2.1.5. Screen Navigation ............................................................................................................................... 8

2.2. TERMINOLOGY ..................................................................................................................................... 8

TOTAL RECALL .............................................................................................................................................. 9

3. OVERVIEW OF TOTAL RECALL ............................................................................................................. 9

3.1. WHAT IS TOTAL RECALL? ................................................................................................................... 9

3.2. STANDARD FEATURES .......................................................................................................................... 9

3.3. OPTIONAL FEATURES ............................................................................................................................. 9

4. COMPLIANCE STATEMENT .................................................................................................................. 10

4.1. EUROPEAN MODEL .............................................................................................................................. 10

4.2. NEW ZEALAND MODEL ......................................................................................................................... 10

4.3. USA MODEL ......................................................................................................................................... 11

5. SAFETY INFORMATION ........................................................................................................................... 12

6. POWER .................................................................................................................................................... 13

7. PREVENTATIVE MAINTENANCE ........................................................................................................... 13

8. CHANNEL UPGRADES .......................................................................................................................... 13

8.1. ANALOG CHANNEL UPGRADES .......................................................................................................... 13

9. UNPACKING ........................................................................................................................................... 14

10. GETTING TO KNOW TOTAL RECALL ................................................................................................ 14

10.1. UNIT LAYOUT – FRONT ......................................................................................................................... 15

10.1.1. Headphone Jack ............................................................................................................................... 15

10.1.2. Line Output Jack ............................................................................................................................... 15

10.1.3. Volume Control Thumb Wheel ........................................................................................................ 16

10.1.4. DVD/CD or Optional BD Writer ...................................................................................................... 16

10.1.5. Speaker Grill ................................................................................................................................... 16

10.1.6. Cooling Fan Vent ............................................................................................................................. 16

10.1.7. Front Panel On/Off Switch ............................................................................................................... 16

10.2. REAR PANEL ..................................................................................................................................... 16

10.2.1. Remote Connection Ports ............................................................................................................... 17

10.2.2. Line Interface Connectors ............................................................................................................... 17

10.2.3. Power Cable Socket ........................................................................................................................ 17

10.2.4. Power Supply (Standard: Desktop & Rack) .................................................................................... 17

10.2.5. Power Supply (Optional Hot-Swap: Rack only) ............................................................................. 17

11. TOTAL RECALL – ONBOARD CONTROLS ...................................................................................... 18

11.1. CONTROL PANEL .............................................................................................................................. 18

11.1.1. Playback and Navigation Keys ....................................................................................................... 19

11.1.2. Power and Hard Drive Activity LEDs ............................................................................................ 19

QUICK START GUIDE .................................................................................................................................. 20
12. INTRODUCTION ......................................................................................................................................................... 20

13. QUICK START GUIDE – TOTAL RECALL DESKTOP AND RACK ......................................................................................... 20

INSTALLATION .......................................................................................................................................................... 22

14. BEFORE YOU INSTALL .................................................................................................................................................... 22

14.1. EXTENSIONS .......................................................................................................................................................... 22

14.1.1. How Extensions are Identified from Call Signalling .......................................................................................... 22

14.1.2. Capturing the Analog Signal ................................................................................................................................ 23

14.2. NETWORKING ...................................................................................................................................................... 23

14.2.1. Virtual LAN Support ........................................................................................................................................ 24

14.2.2. QoS Support .................................................................................................................................................... 24

14.3. NETWORK SHARES (OPTIONAL – TR RACK ONLY) .................................................................................................. 24

14.3.1. NFS Network Share ........................................................................................................................................ 24

14.3.2. Windows Network Share .................................................................................................................................. 25

15. CONNECTING TO ANALOG SIGNAL LINES .................................................................................................................. 26

15.1. CONNECTION .......................................................................................................................................................... 26

15.1.1. Signal Sources .................................................................................................................................................. 26

15.1.2. DSP Cards ....................................................................................................................................................... 26

15.2. ANALOG TELEPHONE NETWORKING .................................................................................................................. 27

15.2.1. Connecting to the Telephone Network .............................................................................................................. 27

15.2.2. Location of the Recorder .................................................................................................................................... 27

15.2.3. Connecting to Analog Lines ................................................................................................................................ 27

15.2.4. Connecting to Digital Phones ................................................................................................................................ 29

15.2.5. DTMF/CLI/Extension Capture .......................................................................................................................... 30

16. SWITCHING ON AND GETTING STARTED ................................................................................................................... 31

16.1. STARTING UP .......................................................................................................................................................... 31

16.2. USING THE CONTROL PANEL .................................................................................................................................. 31

16.2.1. MENU Key ...................................................................................................................................................... 31

16.2.2. SELECT Key ................................................................................................................................................... 32

16.2.3. Up and Down Arrow Keys .................................................................................................................................. 32

16.2.4. Numeric Keypad ........................................................................................................................................ 32

16.2.5. Playback Control Keys ...................................................................................................................................... 32

16.3. USING THE GRAPHICAL USER INTERFACE ....................................................................................................... 32

16.3.1. Using the GUI ................................................................................................................................................... 32

16.3.2. Cancelling ....................................................................................................................................................... 33

16.4. TOTAL RECALL GUI MENUS ...................................................................................................................................... 34

16.4.1. Options Menu .................................................................................................................................................. 34

16.4.2. Search Menu .................................................................................................................................................. 34

16.4.3. Logging Menu ................................................................................................................................................ 34

18. CONFIGURATION .......................................................................................................................................................... 35

17. MENU SITE MAP & DEFAULT PARAMETERS .................................................................................................................. 35

18. CONFIGURING TOTAL RECALL ...................................................................................................................................... 38

18.1. LICENSED FEATURES (RACK MODEL ONLY) .......................................................................................................... 38

18.2. ABOUT THE OPTIONS MENU ...................................................................................................................................... 38

18.3. GENERAL SETTINGS ................................................................................................................................................ 39

18.3.1. Language ...................................................................................................................................................... 39

18.3.2. Time & Date .................................................................................................................................................. 40

18.3.3. User Session ................................................................................................................................................... 41

18.3.4. Recent Calls .................................................................................................................................................. 42

18.3.5. User Password ........................................................................................................................................ 43

18.3.6. Administrator Password ................................................................................................................................... 43

18.4. ANALOG SETTINGS .................................................................................................................................................. 44

18.4.1. Trigger Type .................................................................................................................................................. 45

18.4.2. Beep ......................................................................................................................................................... 46

18.4.3. Detect DTMF .............................................................................................................................................. 46
27.2.2. Modifying Existing Remote Manager User Accounts................................................................. 77
27.3. REFRESH VIEWS ............................................................................................................................ 77
27.4. CHOOSE LANGUAGE SETTINGS .................................................................................................... 77

28. TR CONFIGURATION TAB ............................................................................................................... 78

28.1. EXTENSIONS ................................................................................................................................. 78
28.1.1. Recording Policies...................................................................................................................... 79
28.1.2. Event Policies ........................................................................................................................... 82
28.2. ARCHIVE ......................................................................................................................................... 83
28.2.1. Auto Archive ............................................................................................................................. 83
28.2.2. Manual Archive .......................................................................................................................... 85
28.2.3. Search Archive ............................................................................................................................ 85
28.3. NETWORK ........................................................................................................................................ 86
28.3.1. Network Interfaces .................................................................................................................... 86
28.3.2. Remote Manager Related Settings Pane ..................................................................................... 86
28.4. GENERAL ......................................................................................................................................... 87
28.4.1. User and Administrator Passwords ........................................................................................... 87
28.4.2. Recorder ID ................................................................................................................................ 87
28.4.3. Session Settings ......................................................................................................................... 88
28.4.4. Recent Calls Settings ................................................................................................................... 88
28.5. CALL .................................................................................................................................................. 88
28.5.1. Minimum Recording Length ........................................................................................................ 89
28.5.2. Max. Recording Length ............................................................................................................... 89
28.5.3. Max. Call Lifetime ......................................................................................................................... 89
28.5.4. VOX Timeout .............................................................................................................................. 89
28.5.5. Recording Period .......................................................................................................................... 90
28.6. TIME DATE ....................................................................................................................................... 91
28.7. ROD AGENTS ................................................................................................................................. 92
28.8. SIGNALLING MAPPING (TR RACK ONLY) .................................................................................... 93
28.8.1. Creating Signalling Map Entries ................................................................................................ 94
28.9. INTERNAL DIAL PLAN (TR RACK ONLY) ..................................................................................... 95
28.10. ANALOG ....................................................................................................................................... 96
28.10.1. Trigger Type ............................................................................................................................... 96
28.10.2. Beep ........................................................................................................................................... 98
28.10.3. Detect DTMF .............................................................................................................................. 98
28.10.4. Extension ................................................................................................................................... 99
28.11. PBX (OPTIONAL – TR RACK ONLY) ........................................................................................... 99
28.11.1. CDR Collector ............................................................................................................................ 100
28.11.2. Collector Type ........................................................................................................................... 100
28.11.3. UDP/TCP .................................................................................................................................. 100
28.11.4. Verifying the Connection ........................................................................................................ 101
28.11.5. CDR Parser ............................................................................................................................... 101
28.12. LICENSE (TR RACK ONLY) ...................................................................................................... 103
28.13. SNMP (OPTIONAL, TR RACK ONLY) .......................................................................................... 104
28.13.1. Agent Configuration .................................................................................................................. 104
28.13.2. IP Address ................................................................................................................................ 104
28.13.3. UDP Port .................................................................................................................................. 104
28.13.4. Read-only Community .............................................................................................................. 104
28.13.5. Read-write Community ............................................................................................................ 104
28.14. TRAPHOSTS .................................................................................................................................. 105
28.14.1. Traphost ..................................................................................................................................... 105
28.14.2. Community ................................................................................................................................. 105
28.14.3. Trap Type ................................................................................................................................... 105

29. SYSTEM MAINTENANCE .................................................................................................................. 106

29.1. SYSTEM MAINTENANCE OPTIONS ........................................................................................... 106
29.1.1. System Information ..................................................................................................................... 106
29.1.2. Archive ........................................................................................................................................ 107
29.1.3. Rebuild TR Database ................................................................................................................... 108
29.1.4. Update TR Software ................................................................................................................... 108
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>29.1.5</td>
<td>Load TR Settings</td>
<td>109</td>
</tr>
<tr>
<td>29.1.6</td>
<td>Save TR Settings</td>
<td>109</td>
</tr>
<tr>
<td>29.1.7</td>
<td>Shutdown</td>
<td>109</td>
</tr>
<tr>
<td>30.</td>
<td>EVENT LOG TAB</td>
<td>110</td>
</tr>
<tr>
<td>30.1.</td>
<td>EVENT TYPES</td>
<td>110</td>
</tr>
<tr>
<td>30.2.</td>
<td>USING THE EVENT LOG</td>
<td>110</td>
</tr>
<tr>
<td>31.</td>
<td>CONNECTING THROUGH FIREWALLS</td>
<td>111</td>
</tr>
<tr>
<td>31.1.</td>
<td>EXAMPLE 1: INTERNAL RECORDER, EXTERNAL PC</td>
<td>111</td>
</tr>
<tr>
<td>31.2.</td>
<td>EXAMPLE 2: EXTERNAL RECORDER, INTERNAL PC</td>
<td>112</td>
</tr>
<tr>
<td>31.3.</td>
<td>EXAMPLE 3: MULTIPLE REMOTE MANAGER CLIENTS BEHIND A FIREWALL</td>
<td>113</td>
</tr>
<tr>
<td>31.4.</td>
<td>LIMITATIONS OF FIREWALLED CONNECTIONS</td>
<td>114</td>
</tr>
<tr>
<td>31.4.1.</td>
<td>Transfer of Files</td>
<td>114</td>
</tr>
<tr>
<td>32.</td>
<td>INTRODUCTION</td>
<td>115</td>
</tr>
<tr>
<td>33.</td>
<td>SYSTEM REQUIREMENTS</td>
<td>115</td>
</tr>
<tr>
<td>34.</td>
<td>INSTALLATION</td>
<td>115</td>
</tr>
<tr>
<td>35.</td>
<td>CONFIGURATION</td>
<td>116</td>
</tr>
<tr>
<td>35.1.</td>
<td>RUNNING ROD FOR THE FIRST TIME</td>
<td>116</td>
</tr>
<tr>
<td>35.1.1.</td>
<td>Configuration Dialog</td>
<td>116</td>
</tr>
<tr>
<td>35.1.2.</td>
<td>IP Address</td>
<td>116</td>
</tr>
<tr>
<td>35.1.3.</td>
<td>Total Recall Extension</td>
<td>116</td>
</tr>
<tr>
<td>35.1.4.</td>
<td>Total Recall Password</td>
<td>117</td>
</tr>
<tr>
<td>35.1.5.</td>
<td>Total Recall Port Base</td>
<td>117</td>
</tr>
<tr>
<td>35.1.6.</td>
<td>Version</td>
<td>117</td>
</tr>
<tr>
<td>35.2.</td>
<td>ROD AGENTS</td>
<td>117</td>
</tr>
<tr>
<td>35.3.</td>
<td>RECORDING CONTROL</td>
<td>117</td>
</tr>
<tr>
<td>36.</td>
<td>EVENT TYPES</td>
<td>118</td>
</tr>
<tr>
<td>37.</td>
<td>TRAP TABLE</td>
<td>118</td>
</tr>
<tr>
<td>38.</td>
<td>COMSECTR LIMITED PRODUCTS WARRANTY</td>
<td>121</td>
</tr>
<tr>
<td>39.</td>
<td>WARRANTY CLAIMS AND PROCEDURE</td>
<td>124</td>
</tr>
<tr>
<td>39.1.</td>
<td>WHO TO CONTACT</td>
<td>125</td>
</tr>
<tr>
<td>39.2.</td>
<td>WHAT PROCEDURE WILL BE FOLLOWED?</td>
<td>125</td>
</tr>
<tr>
<td>39.3.</td>
<td>WHAT SERVICES WILL BE PERFORMED?</td>
<td>125</td>
</tr>
<tr>
<td>39.4.</td>
<td>IMPORTANT NOTICE: SOLE &amp; EXCLUSIVE REMEDY</td>
<td>125</td>
</tr>
<tr>
<td>39.5.</td>
<td>DISCLAIMER OF WARRANTIES</td>
<td>125</td>
</tr>
<tr>
<td>40.</td>
<td>COMSECTR SOFTWARE LICENCE</td>
<td>125</td>
</tr>
<tr>
<td>41.</td>
<td>GNU PUBLIC LICENSE</td>
<td>130</td>
</tr>
</tbody>
</table>
About this Manual

1. Introduction

This manual is intended for technical and/or network administrators who will be installing and configuring Total Recall and the associated PC client software.

Refer to the Total Recall User Guide for information about using Total Recall’s recording features and functionality.

2. Conventions and Terminology

2.1. Conventions

2.1.1. References

References to other manuals or other parts of this manual are indented, formatted in blue text, and marked with a hand symbol:

Reference example

2.1.2. Notes

Notes are indented, formatted in blue text with light gray borders, and marked with a note symbol:

Note example

2.1.3. Warnings

Warnings are indented, formatted in blue text with light gray borders, and marked with a warning symbol:

Warning example

2.1.4. Procedures

Descriptions of procedures for performing certain tasks are marked with a ‘cogs’ icon, and the purpose of the procedure is formatted in bold italic text:

Procedure Description Example

1. Procedural step example
2.1.5. Screen Navigation

Screen navigation (indicating the navigation required to reach the relevant screen or dialog) is formatted in blue text and marked with a menu icon:

_Options Menu > General Settings_

2.2. Terminology

The following table lists some writing style conventions used in this manual and their associated meanings.

<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Select OK to save your settings’</td>
<td>Highlight (position the cursor over) the OK screen button, and press the [SELECT] key on the control panel</td>
</tr>
<tr>
<td>‘Select a date from the list…’</td>
<td>Highlight the relevant data field, and press the [SELECT] key repeatedly to cycle through the available options, until you reach the required value</td>
</tr>
<tr>
<td>‘Check the Recording Period check box’</td>
<td>Highlight the relevant check box, and press the [SELECT] key to populate it with a check mark</td>
</tr>
<tr>
<td>‘Enter the IP address…’</td>
<td>Highlight the relevant data field, and enter the IP address using the numeric keypad on the control panel</td>
</tr>
</tbody>
</table>

❖ See the _Total Recall User Guide_ for information on using the menu system.
3. Overview of Total Recall

3.1. What is Total Recall?

Total Recall is a range of compact, cost-effective and self-contained digital voice loggers and recorders that provide secure audio capture and storage for up to 350,000 records or 60,000 recording hours of calls and/or other audio signals.

Total Recall is easily operated via a simple control panel and intuitive menu system, or remotely via a network using the Remote Manager Client software that is included with unlimited licenses as part of your solution.

Record on Demand software (also supplied with unlimited licenses) may be installed onto users’ PCs to allow configurable control over the calls that are recorded on their channel.

Depending on network type and configuration, Total Recall can also record the telephone numbers of incoming and outgoing calls, the time and date of the call, the duration of the call, and reference to a specific channel number or extension. All of this information can be used to search and retrieve calls from the internal hard drive database or from archive media.

3.2. Standard Features

- Compact, self-contained, easy to install and operate.
- Record analogue telephone conversations.
- Record other analogue audio signals, such as two-way or broadcast radio.
- Onboard storage for up to 350,000 records/60,000 hours of calls.
- Archive recordings to DVD+RW, CD-R, CD-RW or (optional) BD-RE.
- Secure and tamper proof recording format.
- Export to MP3, WAV or secure TRC format.
- Policy based recording control.
- One-click real-time monitoring of calls.
- Email and copy calls directly from Remote Manager on your Windows 2000/ME/XP/Vista-32/Vista-64 PC. Supplied free-of-charge and license free.
- Powerful search capability.
- Feature-rich call player.
- All remote access, monitoring and management software included.

3.3. Optional Features

- Blu-Ray (BD-RE) Archive Device (optional on both Desktop and Rack models).
- Dual Hot-Swap Power Supplies (optional on Total Recall Rack model only).
• Channel Upgrades: **Total Recall Desktop** can accommodate two Digital Signal Processor (DSP) cards, and **Total Recall Rack** can accommodate four DSP cards. Systems may be upgraded with 4, 8 or 12 channel cards.

• Software Upgrades (optional on **Total Recall Rack** model only):
  - TCP/IP Network Call Archiving.
  - Simple Network Messaging Protocol (SNMP) Alarm Interface Support.
  - Station Messaging Detail Record (SMDR) Support.

Contact your supplier for more information on obtaining upgrades for your **Total Recall** system, or see [www.totalrecallvr.com](http://www.totalrecallvr.com)

## 4. Compliance Statement

### 4.1. European Model

<table>
<thead>
<tr>
<th>The equipment has been approved in accordance with Council Decision 98/482/EC for pan-European single terminal connection to the public switched telephone network (PSTN). However, due to differences between the individual PSTNs provided in different countries, the approval does not, of itself, give an unconditional assurance of successful operation on every PSTN network termination point.</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the event of problems, you should contact your equipment supplier in the first instance.</td>
</tr>
<tr>
<td>This device is designed to work on any network. This device is not dependent on physical and software switch settings. If this device is to be used outside of your area or different network, contact your vendor.</td>
</tr>
<tr>
<td>This device complies with Class A of EN55022: 1995 incl. Amendments 1 &amp; 2.</td>
</tr>
<tr>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td>This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.</td>
</tr>
</tbody>
</table>

### 4.2. New Zealand Model

<table>
<thead>
<tr>
<th>This device complies with Class A of AS/NZS3548:1995, incl. Amendments 1 &amp; 2.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td>This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.</td>
</tr>
<tr>
<td>8.1.8 Call logging (automatic set-up).</td>
</tr>
<tr>
<td>(b) “The call log incorporated in this equipment does not record all answered calls. The call log, therefore, may not agree with the Telecom account which may include calls not shown on the log.”</td>
</tr>
<tr>
<td>8.5 Recording functions.</td>
</tr>
<tr>
<td>(c) “All persons using this device for recording telephone conversations shall comply with New Zealand law. This requires that at least one party to the conversation is to be aware that it is being recorded. In addition, the Principles enumerated in the Privacy Act...”</td>
</tr>
</tbody>
</table>
1993 shall be complied with in respect to the nature of the personal information collected, the purpose for its collection, how it is used and what is disclosed to any other party.”

4.3. USA Model

FCC Rules, Part 15

Total Recall has been tested and complies with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, can cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at the user’s expense.

CHANGES OR MODIFICATIONS NOT EXPRESSLY APPROVED BY Consec TR Pty Ltd COULD VOID THE USER’S AUTHORITY TO OPERATE THE EQUIPMENT.

1. FCC Part 68 Registration

Total Recall complies with FCC Rules, Part 68, and the requirements adopted by ACTA. On this equipment is a label that contains, among other information, the FCC Part 68 registration number. If requested, this number must be provided to the telephone company.

2. REN

The ringer equivalence number (REN) is used to determine the quality of devices, which may be connected to the telephone line. Excessive RENs on the telephone line may result in the devices not ringing in response to an incoming call. In most, but not all, areas the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company.

NOTE: RENs are associated with loop-start and ground-start ports. It is not used for E&M and digital ports. The REN assigned to Total Recall is 1.5B. If requested, this information must be given to the telephone company.

3. Service

In the event of equipment malfunction, all repairs should be performed by Consec TR Pty Ltd or an authorized agent. It is the responsibility of users requiring service to report the need for service to Consec TR Pty Ltd or to one of our authorized agents. Service can be facilitated through our Factory office at:

Consec TR Pty Ltd,
Unit 5, 7 Millennium Court, Silverwater, NSW 2128, Australia
Email: totalrecall@totalrecallvr.com Web: www.totalrecall.com

For USA and Canada, contact: Omnicron Electronics
581 Liberty Highway, Putnam, CT 06260
Web: www.omnicronelectronics.com Phone: (860) 928-0377 Fax: (860) 928-6477

The telephone company can ask you to disconnect the equipment from the network until the problem is corrected or until you are sure that the equipment is not malfunctioning.

4. Facility Interface Information
In order to connect registered terminal equipment to the telephone company lines, the terminal equipment must utilize an FCC registered jack. Standardized jacks are used for this equipment. The following table contains Facility Interface Code (FIC), Ringer Equivalence Number (REN), Service Order Code (SOC) and network jack information for the equipment.

<table>
<thead>
<tr>
<th>Port Identifier</th>
<th>FIC</th>
<th>REN</th>
<th>Network Jack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1 to 48</td>
<td>N/A</td>
<td>1.5B</td>
<td>RJ11C</td>
</tr>
<tr>
<td>Link 1 to 4</td>
<td>N/A</td>
<td>N/A</td>
<td>RJ48C</td>
</tr>
</tbody>
</table>

The **Total Recall interface** connects to the Public Switched Telephone Network through a FCC registered NCTE that specifies the type of network jack to be used.

5. **Disruption to the Network**

If the **Total Recall disrupts** the telephone network, the telephone company can discontinue your service temporarily. If possible, the telephone company will notify you in advance. If advance notice is not practical, they will notify you as soon as possible. You are also informed of your right to file a complaint with the FCC.

6. **Telephone Company Facility Changes**

The telephone company can make changes in its facilities, equipment, operations, or procedures that can affect the operation of your equipment. If they do, you should be notified in advance so you have an opportunity to maintain uninterrupted telephone service.

7. **Electrical Safety Advisory**

While **Total Recall** is fully compliant with FCC rules and regulations, it is recommended that an alternating current (AC) surge arrester of the form and capability suitable for the model purchased be installed in the AC outlet to which the Comsec TR Pty Ltd products are connected. Consult with your distributor as to the surge protector requirements for your equipment.

**Notes:**

a) *If a ruling is required on the legality of recording in your country, please seek legal advice.*

b) *This product must not be used for illegal or unauthorized recording purposes.*

---

**5. Safety Information**

⚠️ **WARNING: Potential electrical shock hazard.**

Always follow basic safety precautions when using this product to reduce the risk of injury from fire or electrical shock. The **Total Recall** must be installed by qualified service personnel. Observe the following:

1. Read and understand all instructions in the user manuals.

2. Observe all warnings and instructions marked on the product.
3. Use only a grounded electrical outlet when connecting Total Recall to a power source. If you are unsure the outlet is grounded, have a qualified electrician check this.

4. First connect the Total Recall to grounded electrical outlet, and only then connect the appropriate interface lines.

5. Do not touch the contacts on the ends of any of the cables used with Total Recall. If any cable becomes damaged, have it repaired immediately.

6. Shut down and unplug Total Recall from power outlets and telephone jacks prior to cleaning.

7. Do not open Total Recall. There are no user serviceable parts inside Total Recall. Refer all servicing to qualified personnel.

6. Power

**Total Recall Desktop:**
- Single Mini-ATX auto sensing 100-240 VAC, 50-60 Hz 180W PSU.

**Total Recall Rack:**
- Standard Single Mini-ATX auto sensing 100-240 VAC, 50-60 Hz 180W PSU.
- Optional Hot-Swap 300+300W PSU.

The maximum power draw for Total Recall Desktop and Rack is 80W.

7. Preventative Maintenance

The Total Recall recorder needs regular maintenance to ensure maximum performance at all times.

As with most computing devices, Total Recall has a fan that provides airflow across the processor to keep it cool, and a filter to ensure that the air is clean.

Every 3 months a message will appear on the Total Recall screen to indicate that filter maintenance is required.

The filter should be washed in warm soapy water, and then rinsed thoroughly and allowed to dry completely prior to being replaced.

New filters are available from your supplier. After maintenance is complete, select OK to remove the message.

8. Channel Upgrades

8.1. Analog Channel Upgrades

Total Recall analog channel upgrades require additional interface cards, which are available in 4, 8 or 12 channel capacities per card. TR Desktop can accommodate 2 analog interface cards (for a maximum of 24 channels), while TR Rack can accommodate 4 analog interface cards (for a maximum of 72 channels).
9. Unpacking

Total Recall is supplied with the following items:

- Total Recall unit.
- On / Off Key.
- Remote Manager CD (PC client software).
- Record On Demand CD (PC client software).
- Power cable.
- A blank CD-R.
- This Total Recall Installation and Administration Guide.
- Total Recall User Guide.
- A crossover network cable for connecting directly to a PC.
- 4 x 19” rack mounting screws & nuts (Rack unit only).

Telephone line cables are not supplied with Total Recall, as individual installations may require differing lengths of cable.

If connection is required to the MDF or distribution frame, it is advisable to have a certified telecom technician install the telephone cabling required for the recorder.

To prevent loss of power and interruptions to recordings, it is very important to connect Total Recall to a UPS power system. Due to the nature of Total Recall’s database, power disruption during recording may cause damage to open files, and the recordings may be lost entirely.

10. Getting to Know Total Recall

Total Recall is simple to operate, is fully self-contained and can be operated using the built-in controls and display panel.

It is not necessary to attach a PC and monitor as a management console for the recorder. However you may configure and operate your Total Recall via a networked PC and the included Remote Manager software if you wish.

See Total Recall Remote Manager on page 62 for more information on using & configuring your Total Recall via a network or dialup connection.
10.1. Unit Layout – Front

10.1.1. Headphone Jack

This is a standard 3.5mm three conductor stereo audio jack for connection of headphones or external speaker, volume controlled via the thumb wheel.

10.1.2. Line Output Jack

This is a standard 3.5mm three conductor stereo audio jack for connection to a tape recorder or the line input of a PC. This output is not volume controlled.
10.1.3. Volume Control Thumb Wheel

A thumb wheel to adjust internal speaker volume.

10.1.4. DVD/CD or Optional BD Writer

A standard DVD/CD or optional Blu-Ray read/write unit with standard DVD player/recorder controls.

10.1.5. Speaker Grill

This is a grill that is located on the left side of the unit. It protects the in-built speaker.

10.1.6. Cooling Fan Vent

This is an opening that is located at the base of the unit (Desktop unit), or the top left-hand corner of the front panel (Rack unit). It is protected by a grill, and acts as an air intake for the unit. The grill is removable to allow access to the filter media for cleaning or replacement.

10.1.7. Front Panel On/Off Switch

The Key Switch is located on the left side of the front panel for both Desktop and Rack units. This is used to power off/on the unit after a Software Upgrade for example.

It is recommended that the On/Off Switch Key is not left in the switch to prevent accidental powering off the unit.

10.2. Rear Panel

![Rear Panel Diagram]

*Total Recall – Desktop Model*
10.2.1. Remote Connection Ports

One standard RJ45 port (8P8C) is available for TCP/IP network connection.

The Modem (RS232) port is a standard male DB9 socket.

10.2.2. Line Interface Connectors

**Total Recall** has 4, 8, 12, 16, 20, or 24 channel inputs for the **Desktop** Unit, and 4, 8, 12, 16, 20, 24, 28, 32, 36, 40, 44 or 48 channel inputs for the **Rack** Unit. The connectors for the telephone line interface are standard RJ11C/RJ12/RJ14 (6P4C plug).

10.2.3. Power Cable Socket

IEC 90V - 260VAC power cable socket.

10.2.4. Power Supply (Standard: Desktop & Rack)

**Total Recall Rack** and **Desktop** are supplied as standard with a Mini-ATX auto sensing 100-240 VAC, 50-60 Hz 180W maximum.

10.2.5. Power Supply (Optional Hot-Swap: Rack only)

**Total Recall Rack** is available with an optional **Dual Hot Swap** power supply, auto-sensing 100-240 VAC, 50-60Hz 300 watts total.

To remove a hot-swap power supply module, simultaneously push the two black tabs inwards and pull the flip-up handle. A power supply module can be removed while the...
unit is powered up and running, assuming the other module is operational. Removing a power supply module will cause an alarm to sound until it is replaced.

To replace a hot-swap power supply module, remove the faulty module according to the above instructions, and slide a new module into the vacant opening, pushing firmly until the module locks into place.

11. **Total Recall – Onboard Controls**

*Total Recall* is simple to operate, and features a built-in control and LCD display panel for convenient configuration and operation.

11.1. **Control Panel**

![Control Panel Diagram](image)

*Total Recall – Desktop Control Panel*

The color TFT LCD displays the various screens, menus and dialogs. After five minutes of keypad inactivity, the LCD backlight automatically switches off, to extend the life of the backlight (the recorder continues to function normally).

Pressing any key illuminates the LCD backlight.
11.1.1. **Playback and Navigation Keys**

The playback and navigation keys are used to control the playback of recorded calls, and to navigate the screen menus.

**[Menu] Key**

The [Menu] key is used to navigate between the three main menus; Logging, Search, and Options. When [Menu] is pressed with the cursor at the top of one of the three main menus, the cursor moves to the top of the next main menu. The system will “beep” each time the [Menu] key is pressed.

When [Menu] is pressed and the cursor is in the body of a main menu, the cursor will go straight to either the OK or Cancel button, saving keystrokes.

**[Select] Key**

Use the [Select] key to start an operation associated with a highlighted button or item, and to confirm a request.

**[Up] and [Down] Scroll Keys**

The [Up] and [Down] arrow keys are used to navigate within a menu. With each [Up] or [Down] key press, the cursor highlights a different button or item within the menu. As you press the [Up] or [Down] arrow keys, the system will “beep”.

Use the [Down] key to highlight items across the screen from left to right as well as down. Use the [Up] arrow key to move in the reverse direction.

**Call Playback Keys**

During the playing of a call, the “Control Keys” can be used to navigate through the call. The “Control Keys” operate in the same way as the keys on a CD or tape player. They can be used to Stop, Play, Fast Forward and Fast Rewind through a call. Pressing the “Play” key during playback will cause the playback to Pause. Pressing the “Play” key again will continue the call.

Pressing the “Stop” key whilst not playing a call locks the User Interface (the padlock icon on the LCD ‘closes’) when in the Options, Logging and Search Menus. This negates the normal 120-second timeout required for the User Interface to lock.

11.1.2. **Power and Hard Drive Activity LEDs**

- Green is the ‘Power On’ indicator.
- Red indicates hard drive activity.

If the LCD backlight has switched off due to inactivity, the green LED flashes continuously every two seconds. Pressing any key illuminates the LCD backlight and the green LED stops flashing.

Your Total Recall system will continue to record normally while the LCD is turned off.
Quick Start Guide

12. Introduction

This section includes a basic example process for configuring your Total Recall Desktop or Rack with an analog network.

The processes do not cover all system settings (just those that are usually essential for proper operation) and do not take into account individual network characteristics.

13. Quick Start Guide – Total Recall Desktop and Rack

This is an example process for configuring Total Recall for recording from analog signal sources, with Remote Manager access via the LAN if desired.

This process assumes that the recorder has already been physically connected to the analog lines, and to your LAN if desired.

1. Remove your Total Recall from its packaging, and check the contents of the box to make sure everything is there.

2. Connect Total Recall to the analog input lines, and to the power cord.

3. Power up your Total Recall system by inserting the key in the front of the unit and turning it to the right. Your system may take up to three minutes to fully boot.

4. Enter the Administrator Password (default password is 0000).

5. Go to the Options Menu by pressing the [Menu] key twice.

6. Select General Settings by pressing the [Select] key.

   Navigate the menus by using the [Up] and [Down] arrow keys, and [Select] to enter the Menu of choice. Press the <OK> or <Cancel> key to return to the General Settings Menu.

7. Set Language if required.

8. Does your network support Network Time Protocol (NTP)?
   a. Yes: Add NTP server IP address/es
   b. No: Manually set the time, date and time zone

   The call database must be empty when you set the Time Zone

9. Assign an Administrator Password.

10. Navigate to the Analog Settings menu.
11. Configure analog channels as appropriate, including assigning each channel an “Extension” value. This extension value simply assigns the channel a name, and is important in the later setup of your unit.

If you are not connecting your Total Recall unit to a TCP/IP network, there is no need to proceed beyond this point. LAN access is not essential for normal configuration, searching, monitoring, replay or CD/DVD/BD archive functionality, but is convenient for many users.

12. Navigate to the Network Settings menu.
13. Assign an IP address for LAN 1. Specify the netmask and gateway if appropriate.
14. Navigate to the Remote Manager Settings menu.
15. Select the IP address of LAN 1 for remote access.
16. Install Remote Manager on a networked PC.
17. Run Remote Manager on the PC.
18. Follow the on-screen prompts to create an Administrator account.
19. Add a Total Recall to your Remote Manager software (using IP address from step 13).
20. Go to the ‘TR Configuration’ tab on your Remote Manager software.
21. Do you want to use ROD from a remote PC?
   a. Yes: Configure ROD Agents.
   b. No: You’re done!
Installation

14. Before You Install

14.1. Extensions

To maximize the functionality of your recording system, Total Recall needs to establish calling (CLI) and called (DTMF) numbers for recorded calls where possible, so that the direction of the call (incoming/outgoing) can be established. It is also preferable if the system is configured to determine which of these CLI/DTMF numbers are to be categorized as internal numbers, or ‘extensions’.

Refer to pages 20 and 21 of the Quick Start Guide in this manual, or the Extension chapter on page 47 for information about configuring extensions via the Total Recall GUI.

Extensions are a Total Recall concept.Calling or called numbers are classed as internal extensions if they match the Internal Dial Plan, which is user-configured via the unit control panel or Remote Manager.

It doesn’t matter if your Total Recall system is actually installed on the trunk side of your telephone system, or if the system is recording radios or another non-telephony signal source. Assigning an ‘extension’ value to each recording channel is just like giving the channel a unique name, which you can use later for convenient call searching and system configuration.

The Internal Dial Plan can be configured to identify any number as an extension, regardless of whether the signal source is actually located on your premises.

Extension information is used in various ways:

- On the recorder, calls can be searched by extension (which requires an extension name or number to be assigned to each recording channel).
- In Remote Manager (remote monitoring and administration software), monitoring is usually best done by extension, and again, calls can be searched by extension.
- Record on Demand (remote recording control software) is configured on an extension basis.

It is recommended that Total Recall is installed and configured so that calls can be linked to an extension wherever possible.

14.1.1. How Extensions are Identified from Call Signaling

When a call comes in to Total Recall, the following process is followed:

1. The calling (CLI) and called (DTMF) numbers are identified from the call signaling (wherever possible).
2. The numbers are matched against a set of user-configurable ‘Signaling Mapping’ rules, which convert the CLI/DTMF numbers to more convenient values if required. For example, a telephone number could be mapped to a user name, or a ‘direct line’
number for an internal extension could be mapped to a 3-digit internal extension number, for ease of reference and to simplify searching.

See **Signaling Mapping** on page 93 for further information.

If no matches are made, the number is left in its raw state.

3. The mapped values, and any unmapped numbers, are then matched against the user-configurable Internal Dial Plan.

See **Internal Dial Plan** on page 95 for further information.

If any raw number or mapped value matches the Internal Dial Plan, the number is classified as an internal extension by the recorder.

Remote Manager must be used to configure the Signaling Mapping and the Internal Dial Plan.

### 14.1.2. Capturing the Analog Signal

**Extension-Side Analog Recording**

For extension-side (enterprise-side) analog recording, audio from each analog phone line or extension is physically connected to a channel – so if extension information is not present in the signaling, each analog channel can be manually assigned an extension value instead.

This can be done directly on the recorder.

Any analog signal source (for example, a radio station) can be configured as an extension, to allow extension-based searching and monitoring.

**Trunk-Side Analog Recording**

For trunk-side (network-side) analog recording where all calls are routed internally by a PBX, but come in to and go out from one central office number, extension information is not present in the signaling. If extension information is required, it must be obtained from the PBX itself.

In this situation, **Total Recall Rack** may (optionally) analyze SMDRs obtained from the PBX, and link calls to extensions using that data.

For more information about purchasing SMDR integration for your **Total Recall Rack**, contact your dealer or visit [www.totalrecallvr.com](http://www.totalrecallvr.com)

### 14.2. Networking

**Total Recall** can be configured for IP communication by assigning a static IP address and a default network gateway to the network port.
The **Total Recall** is not a routing device for IP traffic. It can connect to multiple networks, however, it will not route traffic between the networks.

The LAN 1 port should always be configured for IP communication and should be used for remote access (using **Remote Manager**) and system monitoring.

### 14.2.1. Virtual LAN Support

The LAN 1 port can be connected to a network that is using VLANs (IEEE 802.1Q). However, the switch should remove (un-tag) and add (tag) the VLAN tag from/to the MAC headers.

### 14.2.2. QoS Support

The LAN 1 port can be connected to a network that uses IEEE 802.1p tags for QoS. However, it is not possible to configure the 802.1p priority for packets from the **Total Recall**.

### 14.3. Network Shares (Optional – TR Rack only)

**Total Recall Rack** can optionally archive to Shared Network Storage. You can use your **Total Recall Rack** and **Remote Manager** PC client software to search archives on Network Shares. In addition, you may use **Remote Manager** to update the information in archives on Network Shares.

A Network Share is either a file system that is part of a Network File System (NFS), or a Windows shared folder. In both cases the Network Share is storage space that physically exists on a machine that is remote to the **Total Recall Rack**.

Use the **Total Recall** to create archives and either the **Total Recall** or the **Remote Manager** to modify the content of the archives. All manual (back-door) changes to an archive will render the archive unusable.

Archiving to Network Shares requires a working network between the machine that provides the storage space, the **Total Recall Rack** and the PC that is used to run your **Remote Manager** client.

Use the LAN 1 port, and the network connected to the LAN 1 port, for IP communication between the **Total Recall Rack** and the machine that provides the network storage space.

#### 14.3.1. NFS Network Share

The **Total Recall Rack** has an in-built NFS Client that uses the user-id and group-id of the UNIX ‘root’ user (user-id of 0 and group-id of 0) to access NFS Network Shares.

Consult your NFS documentation on how to map the user-id and group-id to different values, if required. For example,

```
/local/archives 192.168.1.0/24(rw,all_squash,anonuid=150,anongid=100)
```

The **Total Recall Rack** requires read and write access to create, and add to, archives on a NFS Network Share. However, read access is sufficient to search archives on a NFS Network Share.
Unlike Total Recall, the Remote Manager requires the services of a 3rd party NFS Client to access archives on NFS Shares. The NFS Client software needs to be installed separately from the Remote Manager.

The Remote Manager CD does not contain NFS Client software. However, there are a number of free as well as commercial NFS Clients. Microsoft’s “Windows Services for Unix” product contains a suitable NFS Client and is free to download.


The Remote Manager requires read and write access to modify archives on a NFS Network Share. However, read access is sufficient to search archives on a NFS Network Share.

Incorrect configuration (especially access rights) of the NFS Client and the NFS Network Share is the most common problem when archiving to NFS Network Shares.

14.3.2. Windows Network Share

The Total Recall Rack has an in-built SAMBA Client to access Windows Network Shares.

The SAMBA Client uses the user and group that are specified during configuration to access archives on Windows Network Shares.

The Total Recall Rack requires read and write access to create, and add to, archives on a Windows Network Share. However, read access is sufficient to search archives on a Windows Network Share.

Unlike Total Recall, the Remote Manager depends on Windows to access Windows Network Shares, which are Windows shared folders.

Some versions of Windows, such as Windows XP Home, do not contain the required software to access Windows shared folders.

The Remote Manager requires read and write access to modify archives on a Windows Network Share. However, read access is sufficient to search archives on a Windows Network Share.

Incorrect configuration (especially access rights) of the Windows Network Share is the most common problem when archiving to Windows Network Shares.
15. Connecting to Analog Signal Lines

15.1. Connection

When installing Total Recall for analog recording, care must be taken to capture call signaling wherever possible, to maximize the information that is recorded with each call.

15.1.1. Signal Sources

Total Recall requires 2-wire inputs for analog recording. A digital line signal will first need to be converted to analog before it can be recorded.

Total Recall can be installed to record from almost any line level audio signal source:
- An analog trunk (exchange) line.
- An analog extension line.
- A telephone handset, either analog or digital (via handset splitter / logger patch).
- A digital extension line, using D/A converters.
- A digital trunk line, using D/A converters.
- A radio or other audio signal presented as a two-wire analog interface.

15.1.2. DSP Cards

The Total Recall Desktop recorder can accommodate up to 2 DSP cards (maximum 24 channels), while the Total Recall Rack recorder can accommodate up to 6 DSP cards (maximum 72 channels).

Each DSP card supports either 4, 8 or 12 input channels, via RJ11C/RJ12/RJ14 (6P6C) line interface connectors. The connectors support 2 input lines each. As a result, 4-channel boards have 2 connectors; 8-channel boards have 4 connectors; and 12-channel boards have 6 connectors.

On each connector, line 1 must be wired to pins 3 and 4 of the connector, and line 2 must be wired to pins 2 and 5 of the connector (as in Figure 1 below).

![RJ connector wiring](image)

Analog recorder channel numbering starts with the lines on the left-most connector, where line 1 maps to analog recorder channel 1 and line 2 maps to analog recorder...
15.2. Analog Telephone Networking

15.2.1. Connecting to the Telephone Network

The analog line interface on the Total Recall recorder is a bridging point and not a pass-through point. Therefore, it is not possible to connect the recorder in series with a telephone line or telephone handset/headset.

The analog line interface connection from the recorder must be run back to a termination point. Depending on the application, this termination point is normally a parallel tap to an extension line, a trunk line, or a digital handset/headset.

Most PBX installations have an MDF (Main Distribution Frame) fitted between the incoming trunk lines and the premise equipment. The trunk lines are terminated to the MDF, and then connected through to the PBX.

Similarly, there is normally a distribution frame on the extension (office) side of the PBX. From this frame, the telephone cabling is routed through the office/work area to individual telephones, or telephone connection points.

15.2.2. Location of the Recorder

The recorder can be located near the PBX and distribution frame, or near the designated users in the office area. Care should be taken when planning the installation to ensure that telephone cable runs and ease of access to the recorder are considered.

The area should be dust free and the room temperature should be kept down to an acceptable level.

15.2.3. Connecting to Analog Lines

Total Recall can be connected to the trunk side or the extension side of the PBX, depending on user preferences and operational requirements.

The main difference is that an extension side connection will enable the recording of internal (extension to extension) calls. In this case, the extension number dialed may be recorded as a search field, provided the handset generates a DTMF dialing tone.

If the number of extensions exceeds the number of trunks, and the requirement is only to record external calls, then the recorder can be connected to the MDF or distribution frame on the trunk side.

Connecting on the trunk side will ensure calling number capture, if CLI is activated.
In Figure 2 above, the recorder is patched onto a distribution frame within the communications or PBX room. This assumes that the lines between the PBX and the Phones are 2-wire analog. Only three of the five available extensions will be recorded. If required, the recorder could be located out in the office area and wired back to the distribution frame.

In Figure 3 above, the recorder is patched directly to analog trunk lines. All incoming and outgoing (but not internal) call activity will be recorded. The recorder can be located in the Communication (or PBX) room, or in the front office.
15.2.4. Connecting to Digital Phones

Many PBX installations use digital phones. It is common to have digital signaling on the extension side, with analog trunk lines installed.

It is important to know the configuration of your PBX system before installing Total Recall.

Total Recall will not record a digital line signal directly, so digital to analog (D/A) conversion must occur before the signal reaches the line interface on the recorder.

Total Recall does not provide D/A conversion. A third party product would be required for this function.

Unlike standard two-wire analog, most digital PBXs generate their own signaling protocol, and therefore recording from digital lines or handsets can be different for each application.

Most digital phones have audio signaling in the handpiece, with the speaker (earpiece) and microphone (mouthpiece) channels being connected to the recorder. A Logger Patch can be used to parallel tap this audio signal from the handset, and wire directly back to the recorder.

It is sometimes the case that there is a signal level difference between the speaker and microphone, and therefore, in a recorded conversation, one party may be heard more clearly than the other. (This is a limitation of recording via handset adapters, and not a recorder limitation.)

Combinations of PBX and digital handsets can produce varying signal levels.

It is not possible to capture incoming call (CLI) data on the recorder when using handset adapters, as the recorder connection is to the handset, rather than to the incoming line. With some handsets, standard DTMF signaling tones are not transmitted and thus will not be captured by the recorder.

Logger Patches are available from Total Recall. Your supplier should be able to advise on a suitable Logger Patch which is compatible with the line signaling and wiring of the handsets installed.

The diagram on the following page shows a representation of how Logger Patches may be used to enable recording direct from digital handsets.
Your Total Recall supplier or the Digital phone manufacturer, should be able to advise on a suitable Recorder Adapter, compatible with the Total Recall analog interface.

15.2.5. DTMF/CLI/Extension Capture

For extension side recording, each line is dedicated to a specific channel, and will always record the same channel unless the line is disconnected or physically changed to another port. For trunk side recording, the next call in or out will generally pick up the next available phone line and will be recorded on the channel dedicated to that line, so agent calls are not channel specific.

If the recorder is connected trunk side on an analog line and set to VOX activation, and an operator/receptionist answers the incoming call, the recorder will record the operator’s comments, and also the continuing conversation of the call if it is transferred. However, in this scenario, the recorder will not capture the agent’s extension number.

In this situation with a Total Recall Rack, you could also take advantage of the (optional) Station Messaging Detail Record (SMDR) processing capability to extract extension information for each call.

CLI data will only be captured if it is embedded in the incoming call data. The recorder is designed to detect DTMF tones on dialing and display the “Dialed Number” in the Number Field of the call record. If DTMF is not present at the point of recording, then the DTMF number will not be displayed.

Due to differences in international standards for CLI and off hook, CLI captured for an unanswered call will be held for five seconds after the last ring detect. If a new call comes in without CLI within that five second period the previous CLI
may be displayed. If CLI is critical then VOX trigger settings may be better suited to your application.

If CLI signaling is not available, then you should specify an extension name (or number) as part of the analog channel configuration, to provide the Total Recall with more information about where the call originated.

See Analog Settings on page 44, and Extension on page 99 for further information.

16. Switching On and Getting Started

16.1. Starting Up

Once the line interface and network cables have been connected, connect the power cable and switch ON the recorder. The power ON/OFF key switch is located at the front of the unit.

Total Recall must always be shut down properly using the System Shutdown function, found in the administrator-only Options Menu. If Total Recall is powered off without following the proper procedure, open database records can be permanently damaged.

It is strongly recommended that Total Recall is connected to an Uninterruptible AC Power Supply (UPS), to avoid improper system shutdown due to unexpected power events.

Initially, you will see the green power LED illuminate, the red LED will flash to show hard drive activity and you will hear a short beep. Text relating to the Linux boot process will appear on the LCD screen, and then the Total Recall logo will be displayed. A screen will then appear giving you essential recorder information, and a few seconds later the Logging Menu will be displayed with the padlock icon “locked”. This Menu is the “default” Menu that the system will revert to after 120 seconds of inactivity.

Before commencing to navigate the menu structure, enter the password [default 0000] at the Logging Menu and then press [Select]. The padlock icon in the top right corner of the LCD will display as “unlocked”, and you may begin to use the system.

16.2. Using the Control Panel

16.2.1. MENU Key

Use the [Menu] key to move between the three main screens, the Logging Screen, the Search Screen, and the Options Menu.

To move between main screens:

- Press the [Menu] key whilst at ‘root level’ of any of the main screens (that is, with no dialogs open).

When [Menu] is pressed with a dialog open, the cursor either moves straight to either OK or Cancel, or simply closes the dialog, depending on the contents of the dialog.
16.2.2. **SELECT Key**

Use the [Select] key to start an operation associated with a highlighted option or menu item, and to confirm requests.

16.2.3. **Up and Down Arrow Keys**

Use the ↑ [Up] and ↓ [Down] arrow keys to navigate sequentially within a menu or dialog. With each ↑ or ↓ key press, the cursor moves to the next option or menu item.

Press ↓ [Down] to highlight items across the screen from left to right, as well as down.

Press ↑ [Up] to move right to left, as well as up.

The system beeps each time arrow keys are pressed.

16.2.4. **Numeric Keypad**

Use the numeric keypad to enter numerals, and the * key to tag calls.

See the Total Recall User Guide for further information on tagging calls.

16.2.5. **Playback Control Keys**

Use the playback control keys to navigate through a call during playback.

The control keys operate in the same way as the buttons on a CD player. They can be used to play, pause, stop, fast-forward and rewind a call.

See the Total Recall User Guide for further information about using the playback control keys to play calls.

The ■ (stop) key can also be used to lock the user interface.

To lock the user interface, press ■ (stop) in either of the three 3 main screens (Options, Logging or Search), whilst not listening to a call.

This overrides the normal 2 minute timeout required for the user interface to lock automatically.

The padlock icon, which appears in the top right hand corner on the LCD screen, displays in the closed position (🔒) when the user interface is locked, and the open position (🔓) when it is unlocked.

16.3. **Using the Graphical User Interface**

16.3.1. **Using the GUI**

The Total Recall Graphical User Interface (GUI) features a cursor that is moved around the screen using the ↑ (Up) and ↓ (Down) keys.
When the cursor is positioned on an interactive screen item (such as a screen button or a check box), the object becomes highlighted. Pressing [Select] then executes the function that is associated with that screen item.

Various methods are used to indicate that screen items are currently highlighted.

**Buttons**

Screen buttons (for example, menu buttons and **OK** and **Cancel** buttons) ‘pop up’ when they are highlighted, and the button text is shown surrounded by a blue border.

Standard screen button:

![Standard screen button](image)

Highlighted screen button:

![Highlighted screen button](image)

Press the [Select] key to ‘press’ highlighted screen buttons.

**Calls**

Calls are shown highlighted when selected. Press [Select] or ➔ to play highlighted calls.

**Data Fields**

Data fields are shown highlighted when selected and can be edited.

Use the numeric keypad to enter values for numeric data fields. If you enter the wrong value, simply enter another value and it will overwrite the existing value.

Some data fields will clear the current value on the first key press.

Use the [Select] key to cycle through available values for data fields with pre-populated options.

**Check Boxes**

Check box text is shown with a border when selected.

Press the [Select] key to place a check in the check box (referred to in this manual as ‘checking’ the check box).

Data fields associated with check boxes cannot be populated or edited unless the check box is checked.

16.3.2. **Canceling**

Where it appears, you can select the **Cancel** button to return to the previous screen or dialog without executing the current function.
16.4. Total Recall GUI Menus

16.4.1. Options Menu

Used for system configuration, system maintenance and system shutdown.

16.4.2. Search Menu

Used to set search parameters and to search the database or an archived DVD/CD for call replay. Your Total Recall can search and replay archive DVD/CDs created by other Total Recall units, or even archive DVD/CDs from old generation Total Recall systems. Calls found through the search can be tagged for archiving. The Search Menu is also used to manually archive calls to DVD or CD.

16.4.3. Logging Menu

The Logging Menu is the default Menu and is used to view current call data, call activity, call status and playback selected calls. Calls can be tagged and Live Monitoring of calls is enabled from the Logging Menu.
Configuration

17. Menu Site Map & Default Parameters

Listed below are the user selectable/definable options on the Total Recall system, and their default values. Default values are listed in **bold**. Parameters such as language, date, time and time zone may have already been pre-configured by your Total Recall dealer, and as such will vary from the values listed here.

Logging Menu

Search Menu

**Recent Calls (On/Off)**

**Search**

Date

Time

Number

Extension

Tag

  - Tagged Only
  - Untagged Only

**Direction**

  - Incoming
  - Outgoing
  - Internal
  - Unknown

**Channel**

**Search Archive**

**Search DVD/CD**

Search Network Archive (*Will only appear if optioned on TR Rack*)

**Tag All**

**Untag All**

**Archive**

  - All Calls
  - Found Calls
  - Unarchived Calls
  - Tagged Calls

**Archive Device**

**DVD/CD**

Network Share (*Will only appear if optioned on TR Rack*)

Options Menu

**General Settings**

**Language**

**English**

  - Spanish
  - French
  - Portuguese
  - Afrikaans
  - Chinese
  - Korean
  - Japanese
  - Arabic (Islamic Calendar)
  - Arabic (Gregorian Calendar)

**Time and Date**
Use NTP (Yes/No)
NTP Address 1
NTP Address 2
Date
  (Current AEST)
Time
  (Current AEST)
Time Zone Area
  Australia
Time Zone City
  Sydney
User Session
  Enable Timeout (On/Off)
    Idle Timeout (1-10 Mins, default = 2 mins)
Recent Calls
  Update Period (5-60 secs, default = 20 secs)
    Records to Show (1-999, default = 20 records)
User Password
  0000
Administrator Password
  0000

Call Settings
Min Call Length
  Ignore
    1-19 Seconds
Max Call Length
  1-60 Minutes
Max Call Lifetime
  Ignore
    1-24 Months
VOX Timeout
  2-15 Seconds
Recording Period (On/Off)
  08:30 – 19:00

Network Settings
LAN 1 (Recommended for Remote Manager/PC connection)
  IP Address
  Netmask
  Gateway

Extension Settings
Enable Monitoring (On/Off)
ROD Mode
  Record by Default
    Don’t Record by Default
    Add Notes Only
    Record Partial Calls
Allow ROD Phone Key (On/Off)
Add (Custom Extension Settings)
  Extension
  Enable Monitoring (On/Off)
  ROD Mode
    Record by Default
      Don’t Record by Default
      Add Notes Only
      Record Partial Calls
Allow ROD Phone Key (On/Off)

License Settings (Total Recall Rack only)
Hardware Key (Read Only)
VoIP & ISDN License Key (Not Utilised on Total Recall Rack or Desktop)
Feature License Key
Licensed Features (Read Only)

Analog Settings

Trigger
- VOX 1, 2, 3, 4, 5, 6
- Off Hook 1, 2, 3, 4, 5, 6
- Manual
- Off

Beep
- Off
- Low
- Mid
- High

Detect DTMF
- On
- Off

Extension (User Configurable)

Archive Settings

Reminder (On/Off)
- 50% Full
- 75% Full
- 90% Full

Auto Archive Every (On/Off)
- Days/Weeks

Archive Device
- DVD/CD
- Network Share (Will only appear if optioned on TR Rack)

Maintenance

System Information
- Recorder ID (001)
- Rebuild Call Database
- Load Settings From DVD/CD
- Save Settings to DVD/CD
- Erase DVD

Remote Manager

Use Dial-Up (Yes/No)
- IP Address
- Base Port
- Maximum Sessions (05)
- Session Duration (2 hours)
18. Configuring Total Recall

18.1. Licensed Features (Rack Model Only)

The following application features require a Feature License Key to configure and use:

- SMDR Parsing.
- SNMP Alarm Interface.
- Network Archiving.

Your Total Recall Rack system will not support and you will not be able to configure the above features without a valid Feature License Key.

For more information on activating Licensed Features, contact your dealer or visit www.totalrecallvr.com.

18.2. About the Options Menu

(Above is for Rack mount unit, includes License Settings for optional functions)

The Options Menu provides access to the Total Recall system settings and administrative functions. To view the Options Menu, press [Menu] twice from the Logging Screen.

Options that are not available on your recorder will be grayed out and cannot be selected.

The Options Menu can only be accessed by users who have logged in with an administrator password.

The various settings and functions are split out into the following groups, each of which has an associated button in the Options Menu:

- General Settings.
- Call Settings.
• Network Settings.
• Extension Settings.
• License Settings (Total Recall Rack only).
• Analog Settings.
• Archive Settings.
• Maintenance.
• Remote Manager.
• System Shutdown.

For new installations, we recommend that you configure Total Recall in the order that the buttons appear in the Options Menu (from top to bottom, then left to right).

18.3. General Settings

Options Menu > General Settings

Use the General Settings screen to set the preferred display language, time and date, passwords, system timeout and recent call replay settings.

18.3.1. Language

Options Menu > General Settings > Language

Select your preferred display language from the list using the down arrow key, and confirm your selection by pressing the [Select] key.

The Language setting defaults to English.
It is recommended that you restart Total Recall after changing the display language.

18.3.2. Time & Date

Options Menu > General Settings > Time & Date

Use the Time & Date menu to set your Total Recall to the local time and date, as well as to configure your local Time Zone area and city. Time Zone settings are especially important if users in different regions are connecting to your system via Remote Manager.

Time Zone area and city must be configured prior to recording calls. Time zone data is saved with the call, and is used to calculate daylight savings changes or by Remote Manager if a call is being replayed in a different time zone.

Set the local time and date via synchronization with an NTP server (recommended), or manually.

To use NTP to set Total Recall’s internal clock:

1. Check the Use NTP check box by highlighting the check box and pressing the [Select] key.
2. Enter the IP address for at least one NTP server with the numeric keypad.
3. Select your Time Zone Area by highlighting the Area field and pressing [Select] to scroll through the available options. When you have selected your area, press the [Down] button to select your nearest Time Zone City.
4. Select your Time Zone City by scrolling through the available options with the [Select] key. Press the [Down] button when complete.
5. Select OK.

If you enter IP addresses for 2 NTP servers, the top one in the list becomes the ‘preferred’ server, and Total Recall will synchronize with the second server if the preferred server is unavailable.
To set the time and date manually:

1. Enter the current Date by highlighting each field and pressing the [Select] key to scroll through the available options. Numeric fields can be manually entered with the numeric keypad if desired.

2. Enter the current Time (in 24-hour format) by highlighting the Time fields and pressing [Select] to scroll through the available options, or by entering the values on the numeric keypad.

3. Select your Time Zone Area by highlighting the Area field and pressing [Select] to scroll through the available options. When you have selected your area, press the [Down] button to select your nearest Time Zone City.

4. Select your Time Zone City by scrolling through the available options with the [Select] key. Press the [Down] button when complete.

5. Select OK.

18.3.3. User Session

Options Menu > General Settings > User Session

The User Session menu allows an administrator to enable or disable automatic system timeout, and to configure the amount of time that Total Recall will wait without user interaction before timing out. ‘Timing out’ means that the Total Recall locks access to all control panel menus, and will require the entry of an administrator or user password to make system functions accessible to users again.

Total Recall continues to record normally while the control panel is ‘timed out’.

To enable or disable the System Timeout function:

1. Ensure Enable Timeout is highlighted.

2. Press the [Select] key to toggle between enabled (checked) and disabled (unchecked).

To modify the System Timeout period:

1. Ensure Enable Timeout is enabled (checked).

2. Highlight the Idle Timeout period by pressing the [Down] arrow key.

3. Press the [Select] key to modify the system timeout period (1 to 10 minutes).

Disabling the System Timeout function will prevent Total Recall from locking automatically. This means that all system functions will remain available
until the system is manually locked, according to the permissions of the last password used to log in.

The system may be manually locked by pressing the [Stop] key on the unit when no calls are being monitored or replayed.

### 18.3.4. Recent Calls

The Recent Calls menu provides configuration options for quick recall functionality in the Search menu.

See the Total Recall User Guide for more information on using the Search Menu.

The Update Period refers to the frequency that Total Recall will update the search screen with the most recent calls when the Recent Calls toggle button is selected. Records to Show refers to the number of call records that will be displayed in the search menu when the Recent Calls button is selected.

**To configure the Update Period:**

1. Highlight the Update Period field.
2. Press [Select] to cycle through the available options (5 to 60 seconds).

**To configure the number of records shown:**

1. Highlight the Records to Show field by pressing the [Down] arrow key.
2. Use the numeric keypad on your Total Recall to enter the number of records that you would like displayed in the Search menu when using the Recent Calls functionality [0-999].
18.3.5. User Password

Total Recall supports two password levels – the User Password and the Administrator Password.

The Total Recall user interface automatically locks after 120 seconds of inactivity (default setting), and can only be unlocked by entering a password.

The User Password allows access to all functionality, unless an Administrator Password has been assigned – in which case, the User Password does not allow access to the Options Menu, or the option to delete calls from the hard drive during a manual archive.

**To assign a user password:**

1. Enter the new password in the New Password field. The password must be numeric characters only, and may be up to 8 characters long.

   You may also enter a null password, allowing the unit to be unlocked without a password. To enter a null password, simply press the [Select] key in the New Password field.

   Please ensure that your user and administrator password settings comply with your internal data security policies.

2. Re-enter the password in the Confirm New Password field.

3. Select OK.

18.3.6. Administrator Password

If an Administrator Password is assigned, only the Administrator Password allows access to the Options Menu and the option to delete calls during a manual archive. By default, this password is 0000.
To assign an administrator password:

1. Enter the new password in the New Password field. The password must be numeric characters only, 0 to 8 characters long.
2. Re-enter the password in the Confirm New Password field.
3. Select OK.

18.4. Analog Settings

Options Menu > Analog Settings

Use the Analog Settings screen to configure the interface between your Total Recall unit and the analog signal interface. Also, use this menu to assign Extension names or numbers for each channel.

To set Analog Channel Settings:

1. Highlight the channel and press [Select].

   The Add Channel Settings dialog appears:

   2. Use the [Down] arrow key to highlight the field which you wish to configure.

   3. Press [Select] to scroll through the available options. Use the numeric keypad to input a numeric extension value for the channel if desired.

   4. When you have finished configuring the channel, press the [Down] arrow to highlight Apply, and then press [Select]. Alternatively, if you would like to apply the current settings to all channels, highlight Apply All and then press [Select].
18.4.1. **Trigger Type**

The **Trigger Type** determines what type of event will trigger recording on that channel.

The available options are **VOX (1-6)**, **Off-Hook (1-6)**, **Manual** and **Off**.

**VOX (1 - 6)**

VOX is a voice or audio signal trigger. Recording will automatically start when noise is detected on a channel, and will automatically stop when silence is detected (as configured via the **VOX Timeout**).

The default setting, **VOX 4**, corresponds to a -28dBm signal (anything over this level triggers recording).

The highest setting, **VOX 6** (high signal / low sensitivity), corresponds to a -20dBm signal. Channels set to VOX 6 will be triggered by loud conversations or signals, but quieter conversations may fail to trigger recording.

The lowest setting, **VOX 1** (low signal / high sensitivity), corresponds to a -40dBm signal. Channels set to VOX 1 will be triggered by soft conversations or signals, but noisy lines may also trigger recording.

In most cases the default setting (VOX 4) is adequate.

**Off-Hook (1 - 6)**

This is the recommended setting for normal recording on PSTN telephone lines. It will cause a call recording to be automatically triggered when the phone handset is taken Off-Hook, and ended when the handset put back On-Hook. If you are recording telephone calls from analog phone lines (POTS circuits), we recommend that you use this as default trigger setting during the initial set-up.

The **Off-Hook** function is triggered by a voltage change on the line. A drop in voltage (On-Hook voltage is typically 48V DC, Off-Hook voltage is typically 8V DC), will normally provide sufficient voltage change to be detected by the recorder, and activate recording. Replacing the receiver would normally stop the recording.

Different Off-Hook settings are available to provide triggering at different voltages.

The Off-Hook voltage ranges and their corresponding Off-Hook Settings are:

- **Off-Hook #1**: Recording Trigger with Off-Hook voltage below approximately 5 volts and On-Hook is above 7 volts.
- **Off-Hook #2**: Recording Trigger with Off-Hook voltage below approximately 10 volts and On-Hook is above 12 volts.
- **Off-Hook #3**: Recording Trigger with Off-Hook voltage below approximately 14 volts and On-Hook is above 16 volts.
- **Off-Hook #4**: Recording Trigger with Off-Hook voltage below approximately 17 volts and On-Hook is above 19 volts.
- **Off-Hook #5**: Recording Trigger with Off-Hook voltage below approximately 20 volts and On-Hook is above 22 volts.
- **Off-Hook #6**: Recording Trigger with Off-Hook voltage below approximately 25 volts and On-Hook is above 27 volts.

**Example 1**: If the On-Hook voltage is 48volts and the Off-Hook voltage is lower than 15 volts use setting Off-Hook #4.
Example 2: If the On-Hook voltage is 24volts and the Off-Hook voltage is lower than 3 volts use setting Off-Hook #1. If the On-Hook voltage is above the range that is set the channel will start to record.

The Off-Hook voltage ranges may vary slightly due to phone line conditions and component tolerance. Off-Hook #4 would be the recommend setting for most standard phone line recording applications. If the phone line does not have DC voltages that can be sensed by the recorder for start/stop recording so that an off-hook setting does not work satisfactorily, the VOX trigger should be used instead. Each channel can be individually set as is best for its source of conversations. If the Off-Hook setting does not work satisfactorily, the VOX trigger should be used instead.

If a channel is set to Off-Hook and no line is connected to the channel, the channel will commence recording, which can only be stopped by setting the channel to OFF or VOX. Caller ID data (inbound number information - CID) will only be available to the recorder on channels recording directly from phone lines and with the CID data provided by your phone service provider in the Belcore standard format. Caller ID data is not available for channels recording from handset/headset audio.

Manual

This setting prepares the channel to receive manual recording instructions from an external third party applications developed in conjunction with Total Recall. Most installations do not use this setting.

Off

A channel that is set to Off is effectively deactivated and no recording is possible on that channel. It is recommended that all unused analog channels be set to Off.

18.4.2. Beep

Beep (‘pip tone’) is a beep sound generated every 15 seconds to indicate to both parties that the call is being recorded.

In some countries, it may be mandatory to play a beep tone when recording. For some users, it is a matter of preference or company policy.

Total Recall does not transmit a recorded message to advise that recording is taking place. This would be as part of a phone system auto-attendant message if desired.

The Beep setting determines the volume of the beep. The options are Hi, Mid, Low or Off. If not set to OFF, the beep will be active even if the channel Trigger is set to OFF.

The default Beep setting is Off.

18.4.3. Detect DTMF

Total Recall detects DTMF tones during calls on all channels. However, analog channels may be used for recording analog signals other than telephone calls, such as radios or intercoms. Such signals may not carry DTMF tones. However, such signals may contain
audio frequencies that resemble DTMF tones, which Total Recall will incorrectly interpret as DTMF.

Set Detect DTMF to On to enable DTMF detections on channels used to record telephone calls, and to Off for channels that are used for signal sources that do not contain DTMF.

18.4.4. Extension

It is advisable to set an extension value for each connected channel in order to take full advantage of the features on your Total Recall system.

Setting an Extension value for a channel means that:

- Calls (or other recordings) on that channel can be searched for by extension value.
- Extension specific recording policies can be created.
- Extension specific event policies can be created.
- Features such as Record on Demand can be used.

Where an analog channel is used for recording telephone calls, any extension information in the call signaling on the line will override the extension value set for that channel.

18.5. Call Settings

The Call Settings menu allows users to configure certain recording policies for their Total Recall system. Call settings apply to every recording channel on your Total Recall.

To set Call Settings:

1. Highlight the parameter that you wish to change.
2. Press the [Select] key to cycle through the available options.
3. For numeric values, you can also enter the required value on the numeric keypad. For example, entering ‘05’ on the numeric keypad with VOX Timeout highlighted will result in a VOX timeout of 5 seconds being displayed.
4. Select OK.
18.5.1. Min. (Minimum) Call Length

**Total Recall** will automatically discard calls with duration that is less than the **Min. Call Length**.

**Min. Call Length** can be set to **Ignore**, which instructs the **Total Recall** to ignore this parameter, or to a value between 1 and 19 seconds, in increments of one second.

The default setting is **Ignore**.

⚠️ Use caution with this setting – it is usual to record all calls, and only under very specific circumstances (for example, noise spikes external to the recorder causing frequent and unwanted false recordings) that this setting should be changed from the default.

18.5.2. Max. (Maximum) Call Length

**Total Recall** can record calls of virtually any length, but longer calls are broken up into separate records according to the **Max Call Length** setting.

This allows lengthy recordings (for example, AM/FM radio monitoring) to be presented as a series of recordings in manageable lengths.

If a call reaches the **Max Call Length** setting, the record is rolled over to a new record. Rolled-over records are marked with (CONT) after the number in the ‘To’ field on the **Logging** screen.

The **Max Call Length** setting can be between 1 and 60 minutes in increments of one minute, and applies equally to all channels.

The default setting is **60 minutes**.

18.5.3. Max. Call Lifetime

The **Max Call Lifetime** is the maximum time a call record is kept before it is automatically deleted.

**Max Call Lifetime** can be set to **Ignore**, which instructs the **Total Recall** to ignore this parameter, or to a value between 1 and 24 months, in increments of 1 month.

The default setting is **Ignore**.

�建**Max Call Lifetime** set to **Ignore**, call records may still be automatically deleted as part of the automatic cleanup process. See **Deleting Calls** on page 56 for more information.

18.5.4. VOX Timeout

If VOX is set as the recording trigger for a channel, the **VOX Timeout** determines the maximum length of ‘quiet time’ that is permitted before a recording on that channel is terminated.

This ensures that if a call has ended and the phone is not hung up properly, the recorder will not continue to record silence indefinitely.
VOX Timeout settings can be between 2-15 secs, and applies to all channels that have VOX as their Trigger setting.

The default setting is 15 seconds.

In the event that an active call is put on hold, and there is no (or very quiet) 'music on hold' being played, the recording will terminate according to the VOX Timeout setting. When the call recommences, the VOX trigger will immediately open a new record, and the complete conversation will be captured across two recordings.

For channels set to VOX trigger, the interval between calls must exceed the VOX Timeout setting. If a fresh call starts within the VOX Timeout of the previous call, Total Recall assumes it is a continuation of the first call, and both calls will appear as one call record.

18.5.5. Recording Period

Set a Recording Period if you want the system to record only between specific times, for example from 8:00 to 18:00 to record only during business hours.

During non-recording times, the following message is displayed on the control panel LCD screen to indicate that no recording is taking place.

The recording period cannot span midnight.

To set a Recording Period:

1. Check the Recording Period check box by pressing the [Select] key.
2. Press the [Down] arrow to highlight the Hour and Minute fields. Enter start and end times (in 24 hour format).
3. Arrow down and highlight ‘OK’.
4. Press [Select] to confirm your configuration.

18.6. Network Settings

Options Menu > Network Settings

<table>
<thead>
<tr>
<th>Connector</th>
<th>IP Address</th>
<th>Netmask</th>
<th>Gateway</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN 1</td>
<td>192.168.2.193</td>
<td>255.255.255.0</td>
<td></td>
</tr>
<tr>
<td>LAN 2</td>
<td>192.168.2.100</td>
<td>255.255.255.0</td>
<td></td>
</tr>
</tbody>
</table>
Use the **Network Settings** screen to configure the available Ethernet port(s) for IP communication between Total Recall and your network.

**Total Recall Desktop** and **Rack** only have one TCP/IP Ethernet port. Therefore, you will only configure LAN 1. The LAN 2 setting is irrelevant for your TRL or TRR system.

### 18.6.1. Configuring Network Interfaces

**To configure a Network interface:**

1. Highlight LAN1 in the Network Settings screen by pressing the [Down] arrow button.
2. Press [Select] to open the configuration screen for the LAN1 Ethernet port.
3. Press the [Down] arrow to highlight the **IP Address** field. Enter a valid static IP address for your Total Recall unit.
4. Press the [Down] arrow to highlight the **Netmask**, and **Default Gateway** fields. Enter the required values for your network (if appropriate).
5. Press the [Down] arrow to highlight **OK**. Press [Select] to confirm your configuration.

### 18.7. Extension Settings

**Options Menu > Extension Settings**

Use the **Extension Settings** screen to configure default (system-wide) or extension specific recording policies. Extension-specific recording policies apply only to calls to or from a specified extension. The default recording policy applies to calls from or to any extensions which do not have a specific recording policy.

To apply the settings in this menu, you should first assign an ‘Extension’ name or numeric value to each of your recording channels. This is set up in the **Analog Settings** screen, accessed from the **Options Menu**.

Extension specific recording policies have priority over the default recording policy.
Calls between numbers that are not extensions, and calls between unknown numbers, are treated with default Extension Settings.

### 18.7.1. Default (System-Wide) Recording Policies

#### Enable Monitoring

With **Enable Monitoring** checked, calls may be monitored in real-time while recording, either directly from the unit, or remotely using **Remote Manager**.

To enable or disable live monitoring on the whole system, highlighting the **Enable Monitoring** check box, and press the [Select] key to toggle between checked (monitoring enabled) and unchecked (monitoring disabled).

#### ROD (Record on Demand) Mode

**ROD Mode** determines whether the **Total Recall** system will retain or discard recorded calls by default. Thus, this setting not only determines the behavior of the optional ROD software client, but rather how the whole system handles call record storage.

The available options may be set by highlighting the ROD Mode field, and pressing the [Select] key to scroll through the available options. The options are:

- **Record by Default**
  
  **Total Recall** records all calls and stores the recording on disk by default.

  However, if enabled, parties on the call can use a DTMF key sequence or **Record on Demand** to toggle between “discarding” and “keeping” the recording of the whole call.

- **Don’t Record by Default**
  
  **Total Recall** records all calls, but automatically deletes the recording at the end of each call.

  However, if enabled, parties on the call can use a DTMF key sequence or **Record on Demand** to toggle between “keeping” and “discarding” the recording of the whole call.

- **Add Notes Only**
  
  **Total Recall** records all calls and stores the recording on disk by default.

  The parties on the call can not use a DTMF key sequence or **Record on Demand** to control recording. However, they can use **Record on Demand** to add notes to the call while the call is in progress.

- **Record Partial Calls**
  
  **Total Recall** does not record calls by default.

  However, parties on the call can use a DTMF key sequence or **Record on Demand** to toggle between “pausing” and “continuing” recording during the call as many times as they wish.

  **Total Recall** will store only the parts of the call when recording was active.

- **Disallowed**
  
  **Total Recall** records all calls and stores the recording on disk by default.

  The parties on the call can not use a DTMF key sequence or **Record on Demand** to control recording, nor can they use **Record on Demand** to add notes to the call while the call is in progress.
Allow ROD Key / ROD Phone Key

The **ROD Phone Key** parameter allows you to specify a two-digit code that, when entered, will allow users to keep or discard a current call (depending on their **ROD Mode** settings).

To activate **ROD Phone Key**, highlight the Allow ROD Key check box and press [Select] to activate. This will then open a field where you can customize your two-digit DTMF phone key code.

Users can choose to keep or discard a current call, or stop and start a recording (dependant on the ROD Mode settings) by pressing *, then their code on the phone keypad while a call is in progress.

For **ROD Key** recording control, it is not necessary to install **Record on Demand** on your PC or to create **ROD Agent** user accounts in **Remote Manager**.

**ROD Key** functionality relies on the presence of DTMF tones.

18.7.2. Conflicting Extension Policies

In the event of a call between 2 extensions with conflicting extension policies, the settings for the extension with **ROD Mode other than** ‘Record Partial Calls’ will take precedence over the settings for the extension set to ‘Record Partial Calls’.

For example, for a call between extensions A and B, where extension A is set to ‘Record By Default’ with monitoring disabled, and extension B is set to ‘Record Partial Calls’ with monitoring enabled, the policy for extension A applies to the call – the entire call is recorded by default, and monitoring is disabled.

If **ROD Mode** is identical for both extensions, the policy for the extension with monitoring enabled take precedence over the policy for the extension with monitoring disabled.

For example, if extension A is set to ‘Record By Default’ with monitoring disabled, and extension B is also set to ‘Record By Default’ but with monitoring **enabled**, the policy for extension B applies to the call – the call is recorded by default, and monitoring is enabled.

If anyone in your organization specifically does not want any of their calls to be monitored, they must be made aware of the above rules.

18.7.3. Extension-Specific Recording Policies

Monitoring activity, ROD mode and ROD Phone Key can also be configured on a per-extension basis.

**To set extension specific policy:**

1. Use the [Down] arrow button to highlight Add, and then press [Select].
   The Extension Recording Policy dialog appears:
2. Enter the Extension number you wish to create a specific policy for. This needs to be pre-configured in Analog Settings screen, accessed via the Options Menu.

Alpha-Numeric Extensions can only be entered using Remote Manager. Numeric-only Extensions may be entered with the numeric keypad on your unit.

3. Check or uncheck Enable Monitoring to activate or deactivate monitoring on that extension.

4. Set the ROD Mode for the specific extension.

5. Check or uncheck Allow ROD Key and enter a ROD Phone Key as appropriate.

When the required extension-specific policies have been defined, use the [Down] arrow key to highlight OK, and press the [Select] Key to apply your changes.

The extension policy will now appear in the Extension Settings box. Repeat the above process for further extensions as necessary.

In some cases the extension information (which originates at the PBX) may arrive slightly after the recorder has started to record a call. In this event, the default recording policy will be applied to the call until the extension information is available, at which point it will then be treated with the appropriate extension recording policy, if any have been created for that extension. The rules for conflicting extension settings also apply.

To remove an extension policy:

1. Highlight the specialized extension in the Extension Settings dialog and press [Select].

2. Select Remove.

The extension policy is removed from the Extension Settings dialog.

18.8. License Settings (Rack Model Only)

Options Menu > License Settings
Use the License Settings screen to enter new and renewed license keys.

18.8.1. Hardware Key

The hardware key for the Total Recall recorder is displayed as read-only field for reference. You will need to quote this key when ordering optional software upgrades for your Total Recall Rack.

18.8.2. VoIP & ISDN License Key

The VoIP & ISDN License Key is not relevant to the operation of your Total Recall. Please note that your Total Recall Desktop or Rack cannot be upgraded to VoIP or ISDN connectivity. If you are upgrading your telephony system to either of these protocols please contact your Total Recall dealer for information on a suitable replacement system.

18.8.3. Feature License Key

A Feature License Key is required to enable optional functionality on your Total Recall system. The features that may be activated by license key are:

- SMDR Parsing.
- SNMP Alarm Integration.
- Network Archive.

The other listed features will have been activated by default on your Total Recall Rack system.
18.9. Archive Settings

Options Menu > Archive Settings

Use the Archive Settings screen to enable and configure automatic archiving.

**Total Recall** can be configured to archive automatically at specified intervals, and/or to display a reminder when the hard drive reaches a specified percentage of capacity.

When using DVD/CD (or optional BD-RE) as the primary auto-archive device, you should ensure that you have a blank DVD/CD/BD, or one with sufficient space on it, in the **Total Recall** DVD/CD/BD drive.

If there is insufficient space on the DVD/CD/BD to complete the archive, **Total Recall** will archive as much as it can. However, the system will not prompt you to insert additional disks.

The Auto Archive function archives all calls that have not been archived to a DVD/CD (or a Network Share, if this feature has been optioned). **Calls that you have previously manually archived will not be included in the Auto Archive.**

**Archive Reminder**

**Archive Reminder** is a visual and audible reminder of actual disk space used on your system. This reminder will continue to appear even after an automatic archive, as no calls have been removed.

To set the Archive Reminder feature, highlight the Reminder check box with the [Up] and [Down] arrows, and press the [Select] to check the box. Highlight the reminder options field by pressing the [Down] arrow key, and press [Select] to configure the Reminder to begin when the hard drive capacity is at 50%, 75% or 90% used.

**Auto Archive**

**Auto Archive** configures your **Total Recall** to archive to a specified device (by default the DVD/CD drive) at a regular period, without manual intervention.
To set the **Total Recall** to automatically archive, navigate to the Auto Archive check box [Up] and [Down] arrow keys, and press [Select] key to check the box. The archive time interval will now be available for configuration.

Press the [Down] arrow key to highlight the ‘Auto Archive Number’ box and use the [Select] key to cycle through the available options. When complete, press the [Down] arrow key again to highlight the weeks/days options box and press the [Select] key to cycle through the options and make your selection. When complete, use the [Down] arrow to highlight **OK** and press [Select] to confirm your configuration.

Within this screen, **Total Recall** indicates when the next Automatic Archive session will occur based on the present time and the selected time interval. After setting up the Automatic Archive parameters, the first archive will always occur at the following midnight and then the Automatic Archive interval setting will regulate the frequency of subsequent Automatic Archives.

![Tip]

If your **Total Recall** system is unlocked, AND a menu other than the main **Logging**, **Search** or **Options** screens is open at the scheduled auto-archive time, the Total Recall system will assume that you are currently using the unit. Auto-Archive will be delayed until you navigate back to one of the main screens.

### Archive Device

**Total Recall Desktop** may only archive to its built-in DVD/CD device, or optionally to a Blu-Ray device if this has been optioned and installed on the system. As no other archiving options are available on the **Desktop** model, you will have no further options in the Archive Device field.

**Total Recall Rack** may archive to its built-in DVD/CD drive, or optionally to a Blu-Ray device (if installed), or optionally to Network Share storage (if optioned). To select the default location for Auto Archiving, highlight the Archive Device field and press [Select] to scroll through the available options. When finished, press the [Down] arrow to highlight **OK** and press [Select] to confirm your configuration.

![Warning]

Network Shares must be pre-configured with **Remote Manager** before they may be set as an Auto Archive location. Configuration on the host that is managing the Network Share as well **Total Recall** may be required. Your network administrator will supply the **Type**, **Path**, **User** and **Password** parameters for the network share.

### 18.10. Deleting Calls

Administrators may choose to delete calls from the hard disk during manual archiving. Also, calls are automatically deleted when:

- A set period of time has passed since they were recorded (for example, 3 months). This option (**Max. Call Lifetime**) can only be activated by a user with administrator privileges.
- The number of calls on the hard disk reaches 350,000, or 60,000 recording hours. When this happens, the oldest 50,000 calls are automatically deleted, until the number of calls on the hard drive is reduced to 300,000.
Auto-deletion occurs according to the 3 conditions above in the priority that they are listed. To avoid losing calls that have not been archived as a result of automatic deletion, it is important to be aware of recorder capacity and to ensure important calls are archived or saved regularly.

18.11. Maintenance

Options Menu > Maintenance

The Maintenance screen provides access to a range of system information and utilities, including access to upgrade the system software.

18.11.1. System Information

The System Information screen displays useful system information and provides a facility to upgrade the Total Recall software.

The System Information screen includes one editable field, Recorder ID. The Upgrade button initiates the software upgrade procedure.

Recorder ID

For installations that include multiple recorders, it may be useful to be able to identify from which recorder a particular call originated. The Recorder ID value permits this identification (000 to 999).

The call list in the Remote Manager playback screen can be configured to display the Recorder ID against each call.
Upgrade

Use the **Upgrade** button to upgrade the system software. Note that the system will automatically re-boot itself during the upgrade process. Recording does not continue during the upgrade process which may take up to 5 minutes to complete.

- The **Upgrade** function only affects system files. However, it is recommended that you back up all important calls from the call database before you perform an upgrade.
- Your passwords and system settings are not affected by updating the system software.

**To upgrade the software version:**

1. Backup the call database as necessary (either save calls using **Remote Manager**, or archive calls as appropriate).
2. Insert the upgrade CD into the **Total Recall** DVD/CD drive.
3. Use the [Down] arrow key to highlight **Upgrade**, then press [Select]. Follow the on-screen prompts to complete your software upgrade.

18.11.2. Rebuild Call Database

If the call database has been corrupted in any way, it may be necessary to rebuild the database.

Select **Rebuild now** to begin the database rebuild process.

- **No new recording takes place** during the rebuild process, which may take from 1 to 5 hours for a database with 350,000 records.

18.11.3. Save Settings to DVD/CD

**Save Settings from DVD/CD** saves the current **Total Recall** system settings to DVD or CD.
It is advisable to save the system settings after the initial configuration, and also after any major changes to the configuration, so you can roll-back to your initial settings if necessary. To save settings, insert a blank DVD/CD into the DVD/CD drive of your Total Recall system, select Save Settings in the maintenance menu, and then press [Select].

18.11.4. Load Settings from DVD/CD

To load previously saved system settings, select Load Settings from DVD/CD in the maintenance menu. The following screen will appear:

![Load Settings from DVD/CD](image)

Highlight OK by pressing the [Down] arrow, then press [Select] to confirm that you will restart the system to apply the new settings.

Now insert a DVD/CD that contains the saved settings into the drive and select OK to load the settings.

18.11.5. Erase DVD

To erase a currently inserted DVD+RW, select Erase DVD in the maintenance menu. Press the [Down] arrow key to highlight OK, then press [Select] to confirm your selection.
18.12.  Remote Manager

Use the **Remote Manager** screen to configure access for the Remote Manager PC software to your Total Recall via your network or a dial up connection.

### 18.12.1. Configuring Total Recall LAN Access

To configure Total Recall for LAN access, highlight the **IP Address** field by pressing the [Down] arrow. Press [Select] to toggle between the available IP addresses that your unit may use to communicate with Remote Manager. This should be the IP address assigned to the LAN 1 Ethernet port.

Press the [Down] button to enter a value for the **Base Port** if required.

> The Base Port value can be left at the default value (10010) unless you have a specific reason to change it (for example a port conflict on the administration PC).

### 18.12.2. Configuring Total Recall Dialup Access

To configure Total Recall for communication with Remote Manager via a 56k dialup connection, press the down arrow to highlight the **Use Dialup** check box, and press [Select] to activate this option.

All other fields will become read only. The IP address is set to 10.0.1.205, and cannot be changed.

### 18.12.3. Configuring Remote Manager Options

Press the [Down] button to highlight the **Maximum Sessions** option. **Maximum Sessions** is the maximum number of simultaneous monitoring and playback connections from Remote Manager PCs that Total Recall will allow.

If this limit is reached, any further connections are blocked by the recorder, and the Remote Manager displays a message to the user informing them that the limit has been reached.

> The default setting is 5. It is not recommended that you increase this setting unless you are confident that the recorder is running well below capacity at all
times. Allowing too many simultaneous sessions may jeopardize the integrity of your recordings.

Press the [Down] button to highlight the **Session Duration** field. The **Session Duration** is the maximum length of time that a **Remote Manager** monitoring or playback session will be allowed to run for.

This setting is a safeguard to prevent network congestion from ‘infinite’ session times if (for whatever reason) a session is not closed properly. If this limit is reached, the session closes – i.e. the audio stream stops. The **Remote Manager** user is able to reconnect immediately upon initiating some other **Remote Manager** activity.

The **Host Name** value can only be set using **Remote Manager**. If you plan to connect from **Remote Manager** to the recorder via a firewall, you will first need to assign a host name using **Remote Manager** via a LAN or direct connection.

### 18.13. System Shutdown

**Options Menu > System Shutdown**

If **Total Recall** is powered off without following the proper procedure, open database records can potentially be damaged.

For this reason, **Total Recall** should always be shut down properly using the **System Shutdown** function.

**To shut the recorder down:**

1. Select **System Shutdown** in the maintenance menu.
2. Press the [Down] arrow to highlight **OK**.
3. Press [Select] to confirm the system shutdown.
4. Wait until the system displays the message “System Halted”. This means that the system has completely shut down and it is safe to turn the power off.
5. Insert the key supplied with your system into the on/off switch at the front of the unit. Turn it left to power off the system. Alternatively, you may remove the power cord from the back of the system to disconnect power from the system.
Remote Manager

19. Introduction

Remote Manager is Microsoft Windows® compatible software that allows remote access from a PC to one or more Total Recall units, via LAN or dialup. Remote Manager is supplied on CD free-of-charge with all Total Recall systems, for installation and use on as many PCs as required.

Remote Manager can be used to:

- Configure the recorder (Administrator Users Only).
- Play recorded calls from the system or archive media – including archive media from older generation Total Recall systems.
- Monitor current calls in real-time.
- Search the call database.
- Archive recorded calls to CD/DVD or optional BD/Network storage.
- Tag and notate calls on the database.
- Download calls to the local hard drive.
- Email downloaded calls.
- Play and save calls from Total Recall archive discs.
- Generate reports.
- Export calls to .wav, .mp3 or secure .trc formats.

20. System Requirements

Minimum system requirements for Remote Manager are:

- Multimedia PC running Windows 2000/XP/Vista32/Vista64.
- 100Mb free HDD space.
- 256Mb RAM.
- Display resolution 800x600, 256 colors.
- Sound device and speakers.
- LAN device or modem.

Calls that are archived onto DVD, CD or (optional) BD are compressed and stored in a secure proprietary data format (.trc) that cannot be played on a PC unless Remote Manager is installed.

Calls in .trc format can be converted using Remote Manager into .wav or .mp3 files for compatibility with standard media players.

A Remote Manager playback or monitoring session adds 1 Mbps to the network payload. Regardless of your network capacity, we recommend that no
more than 20 Remote Manager sessions connect to a Total Recall at any one time to ensure optimal system performance.

21. Compatibility Between Remote Manager and Total Recall

It is very important to ensure that the software version number of your Total Recall unit matches the software version number of Remote Manager. Incompatible software versions may cause Remote Manager to fail to connect to your Total Recall system, or may exhibit intermittent problems.

Please note that the current generation Remote Manager cannot connect to old generation Total Recall units and vice versa. However you can replay and copy calls from archive discs made with old generation systems.

If your Total Recall system software is upgraded, you will be required to upgrade your Remote Manager program as well. At the time this manual was prepared, the current Total Recall software version was 8.4.0, with the corresponding Remote Manager version being 8.4.0.

Contact your Total Recall dealer to ensure that you are running the latest software version.

22. Installation

When running Remote Manager for the first time, you will be prompted to set up the Administrator account for that PC. Therefore it is very important that installation is carried out by the Administrator themselves or properly authorised personnel.

Remote Manager Software is supplied on a CD together with the Total Recall recorder.

To install, insert the CD into the PC drive, and follow the onscreen instructions from the Installation Wizard. If the install does not start automatically, manually run setup.exe from the disc.

Please check with your system administrator before installing Remote Manager.

Do not insert the CD into the Total Recall DVD/CD drive – Remote Manager is PC software only.

During installation, you will be prompted to specify an install directory and a data directory. The data directory must be accessible for all Remote Manager users on that PC: convenient locations may include C:\Documents and Settings\All Users\ for Windows XP, or C:\Users\Public for Windows Vista.
23. Configuring Total Recall for Remote Manager Access

A Total Recall recorder must be configured to support LAN or dialup access before you can connect to it using Remote Manager.

**To configure your Total Recall unit for Remote Manager access:**

1. Configure the Recorder ID (if you do not wish to use the default value of 1) via the Options > Maintenance > System Information menus. This can be important for call search and replay functionality.

2. Navigate to the Options > Network Settings menu via the built-in LCD and keypad. Configure the LAN 1 network port as required.

3. Navigate to the Options > Remote Manager menu. Select the IP address that you would like to use for the Remote Manager connection (this will be the IP address you set for LAN 1). To connect via a 56k dialup modem, check the ‘Use Dialup’ box at the top of the menu.

24. Administrator Quick-Start Setup

1. Start the Remote Manager application (double-click the desktop shortcut, or select TR Remote Manager from the Windows Start menu).

   The Add User dialog displays. Upon first start-up, you will be directed to create an Administrator account.

2. Enter an Administrator username and password.

   The first user account defaults to an administrator account. Only administrators can add standard user accounts, define the Total Recall recorder that these accounts may connect to, and specify the software privileges of those users.

3. Select your preferred display language.

4. Click OK.

   The Remote Manager main application opens.

5. ‘Add’ one or more Total Recall units, if appropriate.

   See Add TR on page 69 for further information.

6. Create ‘standard’ user accounts as necessary, and configure their access privileges.

   See User Management on page 75 for further information.

7. Add one or more Total Recall units for each standard user as appropriate, and configure their channel/extension access as required.
25. User Interface

Remote Manager is a ‘tabbed’ application, including a Main Menu bar, a Button bar, and 4 tabs:

- Monitor.
- Playback Calls.
- TR Configuration.
- Event Log.

![Remote Manager User Interface](image)

Figure 5 - the Remote Manager User Interface

26. Main Menu Bar

The Remote Manager main menu bar includes 2 menus – the File menu and the Help menu.

26.1. File Menu

The File menu includes the following options:
• **Users**
  Opens the Users dialog (administrators only).

  See *User Management* on page 75 for more information.

• **User Preferences**
  Opens the User Preferences dialog.

  See *User Preferences* on page 67 for more information.

• **Save Call List as**
  Saves the call list displayed in the Playback Calls tab as a .txt or .csv file. The data included reflects the current call list column configuration.

• **Print Preview**
  Opens a print preview of the Call Report.
  The Call Report is a print-formatted version of the call list displayed in the Playback Calls tab. The data included reflects the current call list column configuration.

• **Print**
  Prints the Call Report via the standard Windows print dialog.

• **Advanced**
  Opens the Advanced Settings dialog.
  Use the Advanced Settings dialog to set the local IP address for the PC, and the Manager Base Port.

• **Exit**
  Closes *Remote Manager*.

### 26.2. Help Menu

The Help Menu provides access to:

• **Total Recall** FAQs on the web.
• The *Total Recall* website.
• ‘About’ information (including the *Remote Manager* version number).
27. Button Bar

The button bar provides access to most of the Remote Manager administrative dialogs and functions.

The following table lists the buttons and their uses:

<table>
<thead>
<tr>
<th>Button</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Opens the User Preferences dialog. Use the User Preferences dialog to edit general user preferences and Total Recall connections for the current user.</td>
</tr>
<tr>
<td>Add TR (administrator users only)</td>
<td>Opens the Add Total Recall dialog. Use the Add Total Recall dialog to ‘add’ Total Recall recorders to the Remote Manager settings for the current administrative user.</td>
</tr>
<tr>
<td>Update Users (administrator users only)</td>
<td>Opens the Update Users dialog. Use the Update Users dialog to add and remove user accounts, to modify user permissions and preferences, and to add or remove Total Recall units associated with user accounts.</td>
</tr>
<tr>
<td>Refresh Views</td>
<td>Refreshes the Device Tree and the Local Folders pane to reflect the latest changes.</td>
</tr>
<tr>
<td>Change Language Settings</td>
<td>Opens the Choose Language Settings dialog. Use the Choose Language Settings Dialog to specify the Remote Manager display language.</td>
</tr>
</tbody>
</table>

See below for further information on each button’s function.

27.1. User Preferences

Click the button to open the User Preferences dialog. The User Preferences dialog is also available from the File menu (File > User Preferences).

Use the User Preferences dialog to edit general user preferences for the user who is currently logged in.

For Administrator users, the dialog includes 2 tabs, General and TR Connectivity. For standard user accounts, only General will be available.
27.1.1. General Tab

Use the **General** tab to change the display language and password for the current user. The current software privileges for the logged in account will be displayed as read-only fields.

**To change your Remote Manager display language:**

1. Click the drop-down arrow to the right of the **Language** field and select your preferred language from the list.
2. Click **OK**.

**To change your Remote Manager login password:**

1. Click **Change Password**.
2. Enter the new password in the **Password** field.
3. Re-enter the password in the **Confirm Password** field.
4. Click **OK**.
27.1.2. TR Connectivity Tab

Use the TR Connectivity tab to add and remove Total Recall recorders (for the currently logged in user), or to modify the connection settings for Total Recall recorders that have previously been added.

When you add a Total Recall recorder to Remote Manager, it will appear in your Remote Manager program, and can be searched, monitored and configured.

The settings are preserved when Remote Manager is closed, so there is no need to repeat the process.

27.1.3. Add TR

Click the Add button to begin the process of adding a Total Recall unit to your Remote Manager program. You can also access this menu by clicking the “Add TR” button on the main Remote Manager screen.

A similar dialog (titled Modify Total Recall Settings) is used to edit connectivity settings for recorders that have already been added. When modifying existing settings, the relevant fields are already populated.

The Add TR screen includes 3 tabs: LAN, Dialup and Cascaded. There is also a field to configure Authorized Extensions.
27.1.4. LAN

Use the LAN tab to add a Total Recall that is connected to an internal or external local area network.

To add a Total Recall to a LAN that is behind a firewall, or if the Remote Manager client PC is behind a firewall, see Connecting Through Firewalls on page 111.

To add a LAN Total Recall that is on the same LAN as the Remote Manager client PC:

1. Click the LAN tab if necessary.
2. Click in the IP Address field, and enter the IP address that you configured on the Total Recall recorder for remote administration.

If your network supports Domain Name System (DNS), you can select Host Name and enter the host name instead.

3. Enter the Password for the Total Recall system that you wish to add. This will be the same password that you use to access the recorder via the built-in control panel.

If you wish to use Remote Manager to configure the recorder, the password you enter here must carry administrator privileges.

4. Enter a description for the recorder.
This description is used to identify the recorder in the Remote Manager program.

5. The Base Port value can be left at its default setting (10010) unless you have a specific reason to change it.

6. If required, click the check box to set an external firewall IP address. This setting is only necessary when Remote Manager is behind a firewall, on an internal IP address, and the Total Recall needs to access Remote Manager via that external firewall IP address.

7. Click Set to apply the settings.

To add further Total Recall systems via LAN:
1. Click the Add TR button.
2. Repeat the previously detailed process.

27.1.5. Dialup

Use the Dialup tab to add a Total Recall to your Remote Manager PC software via a 56k dialup modem connection.

To add a Total Recall that is connected via dialup modem:
1. Click the Dialup tab if necessary.
2. Enter the phone number to the modem in the Dialup Number field.
3. Select the Modem you want to use from the drop-down list (if only one is configured on your PC, only one option will be available).
4. Enter the **Password** (this is the PIN code for the **Total Recall** that you wish to connect to).

If you want to use **Remote Manager** to configure the recorder, the PIN you enter here must carry administrator privileges.

5. Enter a suitable description for the recorder.

This description is used to identify the recorder in the **Remote Manager** program.

6. Click **Set** to apply the settings. Remote Manager will dial the recorder before adding it to the software, to verify that the dialup settings are correct.

**To add further Total Recall units via dialup:**

1. Click the **Add TR** button.
2. Repeat the previously detailed process.

### 27.1.6. Cascaded

**Cascaded** recorders are connected via LAN to a *previously added* dialup **Total Recall** recorder. The remote dialup **Total Recall** acts like a central gateway to all the other cascaded units.

To add a cascaded recorder:

1. Click the **Cascaded** tab if necessary.
2. Select the **Dialup Host** (the dialup recorder to which the cascaded recorder is connected) using the drop-down menu.
3. Enter the **IP Address** of the cascaded recorder.

4. Enter the **Password** (the PIN for the **Total Recall**).

   ![](image)

   If you want to use **Remote Manager** to configure the recorder, the PIN you enter here must carry administrator privileges.

5. Enter a suitable description for the cascaded recorder.

   ![](image)

   This description is used to identify the recorder in the **Remote Manager** program.

6. Click **Set** to apply the settings. **Remote Manager** will dial the **Dialup Host** in order to verify the connection with the attached cascade unit.

**To add further cascaded Total Recall units:**

1. Click the **Add TR** button.

2. Repeat the previously detailed process.

### 27.1.7. Authorized Extensions

The Authorized Extensions are those extensions on the **Total Recall** that the selected user is able to monitor, search and play back calls from. To configure the authorized extensions for the selected user, click **modify** in the **Add TR** screen.

Before configuring authorized extensions, you will need to create ‘extension’ values for your channels. See especially Section 28.9 and Section 28.10 of this manual for more information on setting up extensions.

![](image)

**Regular Expressions:** Some **Remote Manager** functionality (including Authorized Extensions) supports the use of regular expressions. Detailed information about regular expression construction can be found here:
To modify authorized extensions:

1. In the Authorized Extensions section, click the Modify button.
2. Select the appropriate option:
   - Authorize all extensions
     The user is able to monitor, search and play back calls from all extensions.
   - Authorize only these extensions
     The user is able to search and play back calls from only those extensions listed in the associated Extensions list.
   - Authorize all extensions apart from the following
     The user is able to monitor, search and play back calls from all extensions except those listed in the associated Extensions list.
3. Populate the Extensions lists as appropriate (see below).

To add extensions or extension ranges to the Extensions lists:

1. Select the appropriate extension selection option.
2. In the Add extension or extension range text field, enter either:
   - An individual extension value
   - A list of comma-separated extension values
   - An extension range
   - A regular expression
     See Regular Expressions on page 73 for further information.
3. Click Add.
   The values are added to the Extensions list.
4. Click OK.
   The table below shows some examples of Extensions list entries and the extensions that would be covered by those entries.

<table>
<thead>
<tr>
<th>Entry Type</th>
<th>Entry</th>
<th>Will Match</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual</td>
<td>100</td>
<td>Extension 100 only</td>
<td>100</td>
</tr>
<tr>
<td>extension</td>
<td>Multiple</td>
<td>Extensions 100, 105 and 106 only</td>
<td>100, 105, 106</td>
</tr>
</tbody>
</table>
To remove extensions or extension ranges from the Extensions lists:

1. Select the value in the Extensions list.
2. Click Remove.
3. Click OK.

27.1.8. Removing a Configured Total Recall

To remove a Total Recall recorder from your Remote Manager program:

1. Select the recorder that you want to remove.
2. Click Remove.
3. Click OK.

27.1.9. Editing the Connection Settings for an Added Total Recall

To edit connection settings for a recorder:

1. Select the recorder that you want to edit.
2. Click Properties.
3. Edit the connection settings as appropriate.

See Add TR on page 69 for further information.

4. Click Set.
5. Click OK.

27.2. User Management

On the main Remote Manager screen, click to opens the Users dialog. Use the Users dialog to add and remove Remote Manager users, and to configure the Total Recall connections and permissions for these users. The Users dialog is also available from the File menu (File > Users).

The user list is specific to the PC upon which Remote Manager is installed.

The user management dialog is only available to Remote Manager Administrator accounts.
27.2.1. Adding Remote Manager User Accounts

1. Click the Add button. The User Preferences dialog opens:

2. Enter a User name for the new user.

3. Set the software permissions for the new user.

   Clicking the check box Set as Admin user will give the new user access to all software functions, and the ability to modify the configuration of all Remote Manager users on that PC.

   Otherwise, un-check the Admin User check-box, and then:

   Check the Allow Monitor check box to give the user access to the Monitor tab of the application.

   Check the Allow Play check box to give the user access to the Playback Call tab of the application.

   Check the Allow Configure check box to give the user access to the TR Configuration tab of the application.

   Check the Allow Log View check box to give the user access to the Event Log tab of the application.

4. Select the preferred display Language for the new user from the drop-down menu.

5. Click Change Password to set the password for the new user account.

6. Click OK.
27.2.2. Modifying Existing Remote Manager User Accounts

1. Select a user from the table in the Users menu.
2. Click the Update Preferences button.
   The User Preferences dialog opens.
3. Edit the user properties as appropriate.

   See User Preferences on page 67 for more information.

4. Click OK.

To remove an existing user:

1. Select the user from the table in the Users menu.
2. Click Remove.

   The remove action is immediate. You will not be asked to confirm the action.

27.3. Refresh Views

Updates the Device Tree and the Modify Local Folders pane to reflect any changes made to recorder connections or local folders made outside of Remote Manager.

27.4. Choose Language Settings

Opens the Choose Language Settings dialog.

Use the Choose Language Settings Dialog to specify the Remote Manager program display language.

To change the language setting:

1. Select the preferred display language from the drop-down list.
2. Click OK.
28. TR Configuration Tab

Use the TR Configuration tab to remotely configure your Total Recall unit(s). Remote Manager will allow full configuration of each Total Recall unit that has been added to your Remote Manager system, assuming that you have administrator rights, or have been given permission to access the unit configuration by the Remote Manager administrator.

All parameters that can be set using the Remote Manager configuration are saved to the Total Recall unit. To begin configuring a Total Recall, click on the TR Configuration Tab and the Total Recall you wish to configure.

Ensure the correct recorder is selected in the Device Tree before making changes to the configuration.

For all configuration tabs, click Apply to save your changes or Restore Previous to cancel your changes.

On Total Recall Rack, the following application features require a Feature License Key to configure and use:

- SMDR Parsing.
- SNMP Alarms.
- Network Archive.

Your Total Recall Rack system will not support and you will not be able to configure the above features without a valid Feature License Key.

If you are using Remote Manager to connect to a Total Recall Desktop system, you will only be able to see and select tabs for the functions available on that system:

28.1. Extensions

The Extensions tab lets you configure recording and event policies for extensions. The Extensions tab contains the following configuration tabs:

- Recording Policies.
- Event Policies.
28.1.1. Recording Policies

Use the **Recording Policies** tab to configure default (system-wide) and extension-specific recording policies. Default recording policies apply to calls to/from extensions which do not have a specific recording policy, while extension specific recording policies apply only to calls to/from specific extensions.

Extension specific recording policies have priority over the default recording policy.

Each recording policy comprises of the following information:

- Whether real-time call monitoring is possible, or not, while recording.
- The method of recording (keep recordings by default, discard recordings by default, only record on ROD software or phone-key command…)
- If parties on the call can use a DTMF key sequence to control (pause, re-start, keep, discard …) recording, and if so, the sequence of DTMF digits that users will use to control recording.

**Enable Monitoring**

With **Enable Monitoring** checked, real-time monitoring of calls is possible while recording, either directly from the recorder, or remotely using **Remote Manager**.

**ROD Mode**

The **ROD Mode** setting determines the method of recording.

The available options from the drop-down menu are:

- **Record by Default**
  
  **Total Recall** records all calls and stores the recording on disk by default.

  However, if enabled, parties on the call can use a DTMF key sequence or **Record on Demand** to toggle between “discard” and “keep” the recording of the whole call.
• Don’t Record by Default
  Total Recall records all calls, but automatically deletes the recording at the end of each call.

  However, if enabled, parties on the call can use a DTMF key sequence or Record on Demand to toggle between “discard” and “keep” the recording of the whole call.

• Add Notes Only
  Total Recall records all calls and stores the recording on disk by default.

  The parties on the call can not use a DTMF key sequence or Record on Demand to control recording. However, they can use Record on Demand to add notes to the call while the call is in progress.

• Record Partial Calls
  Total Recall does not record calls by default.

  However, parties on the call can use a DTMF key sequence or Record on Demand to toggle between “pause” and “continue” recording during the call as many times as they wish.

  Total Recall will store only the parts of the call when recording was active.

• Disallowed
  Total Recall records all calls and stores the recording on disk by default.

  The parties on the call can not use a DTMF key sequence or Record on Demand to control recording, nor can they use Record on Demand to add notes to the call while the call is in progress.

Allow ROD Key / ROD Phone Key

  With Allow ROD Key checked, parties on the call can use a DTMF key sequence to control (pause, re-start, keep, discard …) recording. The ROD Phone Key parameter specifies the DTMF key sequence.

  For ROD Key recording control, it is not necessary to install Record on Demand or to assign ROD Agents in Remote Manager.

  ROD Key functionality relies on the presence of DTMF tones.

Conflicting Extension Policies

  In the event of a call between 2 extensions with conflicting extension policies, the settings for the extension with ROD Mode other than ‘Record Partial Calls’ will take precedence over the settings for the extension set to ‘Record Partial Calls’.

  For example, for a call between extensions A and B, where extension A is set to ‘Record By Default’ with monitoring disabled, and extension B is set to ‘Record Partial Calls’ with monitoring enabled, the policy for extension A applies to the call – the entire call is recorded by default, and monitoring is disabled.

  If ROD Mode is identical for both extensions, the policy for the extension with monitoring enabled takes precedence over the policy for the extension with monitoring disabled.

  For example, if extension A is set to ‘Record By Default’ with monitoring disabled, and extension B is also set to ‘Record By Default’ but with monitoring enabled, the policy for
extension B applies to the call – the call is recorded by default, and monitoring is enabled.

If anyone in your organization specifically does not want any of their calls to be monitored, they must be made aware of the above rules.

To set default recording policy:

1. In the Default Recording Policy pane, check or uncheck Enable Monitoring as appropriate.
2. Select the ROD Mode.
3. Check or uncheck Allow ROD Key and enter ROD Phone Key as appropriate.
4. Click Apply.

To set extension specific recording policy:

1. In the Extension Recording Policies pane, click Add.
   The Add Extension Settings dialog appears.

2. Enter the extension name or number that you wish to create a specific recording policy for.
3. Enter a Description for the extension if desired.
4. Uncheck Enable Monitoring to disable monitoring for the extension if required.
5. Select the required ROD Mode for that extension.
6. Check Allow ROD Key and enter a ROD Phone Key if required.
7. Click OK.
   The extension recording policy appears in the Extension Recording Policies pane.
8. Repeat the above process for further extensions as necessary.
9. Click Apply when you have finished configuring extension recording policies to save your settings.

To remove an extension specific recording policy:

1. Select the extension in the Specialized Extensions pane.
2. Click Remove.
The extension recording policy disappears from the Extension Recording Policies pane.

3. Click Apply.

⚠️ The remove action is immediate. You will not be asked to confirm the action.

### 28.1.2. Event Policies

‘Events’ are activities (or lack of) on a specific extension that **Total Recall** can generate an Event Log entry and an SNMP trap for when detected. The activities that can be configured to generate an ‘event’ are:

- **Call Start**: i.e. an event is generated every time a call starts on a specified extension.
- **Call End**: i.e. an event is generated every time a call ends on a specified extension.
- **Quiet Extension**: i.e. an event is generated when there is a lack of activity (new calls) on a specified extension for a specified period of time.

#### To set extension specific event policy:

1. In the Extension Event Policies pane, click Add.

   The **Add Extension Event Policy** dialog appears.

2. Enter the extension number.

3. Check **Call Start Event** to generate an event every time when a call starts on the specified extension.
4. Check **Call End Event** to generate an event every time when a call ends on the specified extension.

5. Check **Quiet Extension Event** to generate an event if there is no activity (new calls) on the specified extension for a specified period of time, and then enter the period in hours in the **Quiet Extension Period** field.

6. Click **OK**.
   
The extension event policy appears in the Extension Event Policies pane.

7. Repeat the above process for further extensions as necessary.

8. Click **Apply**.

   **To remove an extension specific event policy:**
   
   2. Click **Remove**.
      
The extension event policy disappears from the Extension Event Policies pane.
   3. Click **Apply**.

      The remove action is immediate. You will not be asked to confirm the action.

### 28.2. Archive

The **Archive** tab lets you configure automatic archiving, and also allows to configure network archiving (optional on **TR Rack**) parameters for manual archiving and searching.

The Archive tab contains the configuration tabs for **Auto Archive**, **Manual Archive** and **Search Archive**.

#### 28.2.1. Auto Archive

Use the **Auto Archive** tab to enable and configure automatic archiving.
**Total Recall** can be configured to archive automatically at specified intervals, and/or to display a reminder when the hard drive reaches a specified percentage of capacity.

The **Auto Archive** function archives all calls that have not been archived to a DVD/CD, or to optional BD media or a Network Share. Calls that have previously been manually archived will not be included in the **Auto Archive**.

Ensure that you have a blank DVD/CD/BD, or one with sufficient space on it, in the drive. If there is insufficient space on the DVD/CD/BD to complete the archive, **Total Recall** will archive as much as it can, however it will not prompt you to insert additional disks.

**To Configure Automatic Archive:**

1. Check the **Enable Auto Archive** check box.
2. Enter the **Archive Period** (this will refer to days or weeks, depending on your selection in point 3).
3. Select the **Archive Period Type** (days / weeks).
4. Select the **Archive Device Type**.
   
   To archive to a DVD/CD/BD select DVD/CD and click **Apply**. However, to archive to a Network Share (optional on **TR Rack**), select Network Share and continue as follows:

   5. Select the **Network Share Type**, which may be Windows (WIN) or Linux (NFS) type. Your system administrator will supply these details.
   
   6. Enter the **Network Share Path, User and Password**. Your system administrator will supply these details.

   In the **Network Share User** field, it can be advantageous to enter the credentials in the format DOMAIN\USERNAME, WORKGROUP\USERNAME or PC-NAME\USERNAME. Total Recall will attempt to authenticate your credentials with the network domain server by default, so specifying the domain, workgroup or PC name will be required, depending on the credentials you want TR to use.

7. Select **Apply**.

**To enable Archive Reminder:**

1. Check the **Archive Reminder** check box.
2. Select the capacity threshold at which the reminder will display (available options are 50% / 75% / 90%).
3. Select **Apply**.
28.2.2. Manual Archive

Use the Manual Archive tab to configure a Network Share (optional on TR Rack) for manual archiving. You must configure the Network Share parameters here if you wish to manually archive to a Network Share from the Total Recall Search Menu.

The configuration parameters are exactly the same as the Auto Archive menu in Section 28.2.1.

It is important to configure the access to the Network Share correctly. This requires configuration on the host that is managing the Network Share as well as Total Recall.

28.2.3. Search Archive

Use the Search Archive tab to configure a network share for searching. You must enter the correct network share parameters here if you wish to search an archive on a network share from the Total Recall Search Menu.
28.3. Network

Use the Network Settings tab to configure the Total Recall Ethernet port(s) for IP communication and to specify connection details for Remote Manager access to the Total Recall.

28.3.1. Network Interfaces

The Network Interfaces pane displays a list of all Ethernet ports on the recorder, along with their assigned IP address, netmask, default gateway and usage. Your Total Recall system has one TCP/IP Ethernet port, so only LAN 1 is relevant for your configuration.

To edit a network interface configuration:
1. Select the interface in the Network Interfaces pane.
2. Click Edit.
   The Edit Network Interface dialog displays.
3. Enter the IP Address, Netmask and default Gateway as required.
4. Click Apply.

28.3.2. Remote Manager Related Settings Pane

Use the Remote Manager Related Settings pane to specify connection details for Remote Manager to the Total Recall recorder.

Select the IP address that will be used for communication between Remote Manager and Total Recall (LAN 1) from the drop-down menu, and configure the Max Sessions and Session Duration as required. Maximum Sessions refers to the maximum number of simultaneous Remote Manager connections to the Total Recall system, while Session Duration refers to the total amount of time that a Remote Manager session may remain connected to the unit before timing out.
28.4. General

Use the General tab to set the administrator and user passwords and the recorder ID, as well as to configure the system timeout settings and the refresh rate for ‘Recent Calls’ functionality.

28.4.1. User and Administrator Passwords

Total Recall supports 2 passwords – the User Password and the Administrator Password.

By default the Total Recall user interface automatically locks after 120 seconds of inactivity, and can only be unlocked by entering a password.

The User Password allows access to all functionality, unless an Administrator Password has been assigned – in which case, the User Password does not allow access to the Options Menu, or the option to delete calls from the hard drive during a manual archive.

If an Administrator Password is assigned, only the Administrator Password allows access to the Options Menu and the option to delete calls during a manual archive.

To set the administrator or user password:

1. Click the Administrator Password or User Password button.
2. Enter the password in the Password field.
3. Re-enter the password in the Confirm Password field.
4. Click Apply.

28.4.2. Recorder ID

For installations that include multiple recorders, it may be useful to be able to identify which recorder a particular call originated from. Setting a unique recorder ID permits this function. The call list in the Remote Manager playback screen can be configured to display the recorder ID against each call.
To set the Recorder ID:
1. Enter the ID in the Recorder ID field.
2. Click Apply.

28.4.3. Session Settings

Use the Session Settings menu to enable or disable the system timeout function. Disabling system timeout will prevent Total Recall from automatically locking after a designated time period. Care must be taken with this setting; if system timeout is disabled all unit functions will remain open according to the permissions of the last password entered.

To configure your session settings:
1. Click the Enable Timeout check box to enable or disable automatic system timeout.
2. Enter your desired Timeout Period, in minutes. This is the amount of time that must pass without user interaction until Total Recall will automatically lock itself.
3. Click Apply at the bottom of the menu to save your settings.

28.4.4. Recent Calls Settings

Use the Recent Calls Settings menu to configure the operation of the automatic “recent call recall” functionality in the search menu. The Update Period refers to how frequently Total Recall will refresh the search screen with the most recent calls, while Records to Show refers to how many call records will be displayed on the search screen when in “recent call recall” mode.

To configure your Recent Calls settings:
1. Specify the required Update Period, in seconds.
2. Specify the Number of Records to display in the search screen on your Total Recall system.
3. Click Apply at the bottom of the menu to save your settings.

28.5. Call

Use the Call menu to configure system-wide call handling settings.
28.5.1. Minimum Recording Length

**Total Recall** will automatically discard the record of calls with duration that is less than the Minimum Recording Length.

Minimum Recording Length can be set to 0, which instructs the **Total Recall** to ignore this parameter, or to a value between 1 and 19 seconds, in increments of one second.

The default setting is 0.

Care needs to be taken with this setting – it is usual to record all calls, and only under very specific circumstances (for example, noise spikes external to the recorder causing frequent and unwanted false recordings) that this setting should be changed from the default.

28.5.2. Max. Recording Length

**Total Recall** can record calls of virtually any length, but longer calls are broken up into separate records according to the Max Recording Length setting.

This allows lengthy recordings (for example, radio monitoring) to be presented as a series of recordings in manageable chunks.

If a call reaches the Max Recording Length setting, the record is rolled over to a new record. Rolled-over records are marked with (CONT) after the number in the ‘To’ field on the Logging screen.

The Max Recording Length setting can be between 1 and 60 minutes in increments of one minute, and applies equally to all channels.

The default setting is 60 minutes.

28.5.3. Max. Call Lifetime

The Max Call Lifetime is the maximum time a call record is kept before it is automatically deleted.

Max Call Lifetime can be set to 0, which instructs the **Total Recall** to ignore this parameter, or to a value between 1 and 24 months, in increments of 1 month.

The default setting is 0.

With Max Call Lifetime set to 0, call records may still be automatically deleted as part of the automatic cleanup process. See Deleting Calls on page 56 for more information.

28.5.4. VOX Timeout

If VOX is set as the recording trigger for a channel, the VOX Timeout determines the maximum length of ‘quiet time’ that is permitted before a recording on that channel is terminated.

This ensures that if a call has ended and the phone is not hung up properly, the recorder will not continue to record silence indefinitely.
VOX Timeout settings can be between 2-15 secs, and applies to all channels that have VOX as their Trigger setting.

The default setting is **15 seconds**.

In the event that an active call is put on hold, and there is no ‘music on hold’ being played, the recording will terminate according to the VOX Timeout setting. When the call recommences, the VOX trigger will immediately open a new record, and the complete conversation will be captured across two recordings.

For channels set to VOX trigger, the interval between calls must exceed the VOX Timeout setting. If a fresh call starts within the VOX Timeout of the previous call, Total Recall assumes it is a continuation of the first call, and both calls will appear as one call record.

### 28.5.5. Recording Period

Set a recording period if you want to record only between certain times.

During non-recording times, a message is displayed on the Total Recall LCD to indicate that no recording is taking place.

**To set call handling settings:**
1. Enter the VOX Timeout, in seconds.
2. Enter the Min Recording Length, in seconds.
3. Enter the Max Recording Length, in minutes.
4. Click Apply.

**To set a recording period:**
1. Check the Use Recording Period check box.
2. Click the Start Time or End Time button.
   The Set Time Range dialog displays.
3. Set the required recording period using the sliders.
4. Click Apply.
28.6. Time Date

Use the **Time Date** tab to set the recorder time and date settings. The time and date on the recorder can be set manually, or automatically via an NTP server (recommended).

**To set the time manually:**

1. Click the **Set Time** check box.
2. Click the **Date** button.
3. Set the date using the **Calendar** dialog.
4. Set the **Time** (select hours, minutes or seconds, and enter values using the keyboard, or use the up and down arrows to change the values in increments of 1).
5. Select the **Time Zone Area**.
6. Select the **Time Zone City**.

   The call database must be empty in order to set the Time Zone Area and City.

7. Click **Apply** to save your settings.

**To use NTP (Network Time Protocol) to set the time and date automatically:**

1. Select **Synchronize with Network Clock**.
2. Enter the IP address for at least one NTP server.

   If you enter IP addresses for 2 NTP servers, the top one in the list becomes the ‘preferred’ server, and Total Recall will synchronize with the second server if the preferred server is unavailable.
28.7. ROD Agents

Use the ROD Agents tab to add user accounts (agents) for the Record on Demand (ROD) Client software, included with your Total Recall system. ROD gives users configurable control over recording on their extension via an easy-to-use PC taskbar application.

ROD users must be added as agents on this tab (and the changes applied) before they can log into the ROD Client from their PC.

To add a ROD agent:

1. Click Add Agent.
   The Add Agent dialog displays.

2. Enter the Agent Name. The user must use this name to log into their ROD Client.
3. Enter the Agent Password (alpha/numeric, at least 1 character).
4. Re-enter the Agent Password.
5. Select the preferred display language. This is the language that will be used by the ROD Client when the user logs in.
6. Click OK.
To remove a ROD agent:

- Click the agent in the list and click **Remove Agent**.

  The remove action is immediate. You will not be asked to confirm the action.

To remove all agents:

- Click **Remove All**.

  The remove action is immediate. You will not be asked to confirm the action.

To change an agent’s password or display language:

- Click the agent in the list and click **Change Password** or **Change Language**.

28.8. Signaling Mapping (TR Rack Only)

Use the **Signaling Mapping** tab to configure the conversion of calling and called (‘From’ and ‘To’) numbers extracted from call signaling to alternative values. This may be configured to make call search and replay more convenient, or to expedite the configuration of extensions.

Where a From or To number for a current or recorded call matches a signaling map entry, the ‘mapped’ value will be displayed in its place, in all relevant locations (the **Total Recall** Logging and Search Screens, and the **Remote Manager** Monitor and Playback tabs). For example, if the phone number 123-456-789 was mapped to the value “Head Office”, then “Head Office” would appear in all the relevant locations.

Mapped values can also be used as search criteria on the recorder and in **Remote Manager**.

Numbers that have Signaling Mapping entries can still be used in their raw form as search criteria, but the search results will display the mapped value instead.

Numbers that do not match the Signaling map are displayed in their raw form.
Signaling Mapping entries may be entered as specific one-to-one replacements, or as regular expressions.

See Regular Expressions on page 73 for further information.

28.8.1. Creating Signaling Map Entries

To create a signaling map entry:

1. In the Mapping pane, click Add.
   The Add Signaling Mapping dialog displays.

2. In the Match Expression field, enter a raw value or an expression that defines the matching criteria.

3. In the Replacement field, enter the appropriate replacement value or output variable.

4. Click OK.

The table below shows examples of signaling mapping of various types, plus example input values and the respective mapped output values.

<table>
<thead>
<tr>
<th>Expression Type</th>
<th>Match Expression</th>
<th>Replacement</th>
<th>Example Input</th>
<th>Mapped Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number to extension</td>
<td>0125245678150</td>
<td>150</td>
<td>0125245678150</td>
<td>150</td>
</tr>
<tr>
<td>Number to user</td>
<td>0125245678150</td>
<td>dave</td>
<td>0125245678150</td>
<td>dave</td>
</tr>
<tr>
<td>Extension range</td>
<td>0125245678([0-9]{3})$1</td>
<td>250</td>
<td>0125245678250</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0125245678251</td>
<td>251</td>
</tr>
</tbody>
</table>

To test a signaling map entry:

1. In the Test Mapping pane, enter an example ID in the Test Raw ID field.

2. Click Test.
   The mapped value is displayed in the Mapped ID field.
28.9. Internal Dial Plan (TR Rack Only)

Use the **Internal Dial Plan** tab to define the rules that identify calling or called numbers as ‘extensions’. An ‘extension’ in **Total Recall** is any **Total Recall** recording channel, or any DTMF/CLI number that is included in the **Internal Dial Plan**.

Some **Total Recall** and **Remote Manager** functionality relies on the identification of extensions. **ROD** must be configured on an extension basis. You must either configure the **Internal Dial Plan**, or assign extension values to your analog recording channels in the **Analog** menu.

![Internal Dial Plan](image)

Any mapped values or unmapped numbers that match one or more rules in the Internal Dial Plan are considered to be extensions.

Rules can be entered as specific values, or as regular expressions.

![Regular Expressions](image)

To add a rule to the **Internal Dial Plan**:

1. In the Internal Dial Plan pane, click **Add**.
   The **Add Rule** dialog displays.

2. Enter the extension name or CLI/DTMF number that is to be considered an ‘Extension’ for **Total Recall** (or a valid regular expression).

3. Click **Apply**.
   The rule is added to the Internal Rule list.

The following table shows examples of Internal Dial Plan rules of various types, with example matches:
28.10. Analog

Use the Analog tab to set Trigger Type, Beep Level, as well as to set extension values and control DTMF detection for analog channels.

28.10.1. Trigger Type

The Trigger Type determines what event type triggers recording on that channel.

The available options are Vox (1-6), Off-Hook (1-6) and Off.

VOX (1 - 6)

VOX is a voice or audio signal trigger. Recording is automatically triggered when the system detects noise on a channel, and terminated when silence is detected on a channel (according to the VOX timeout setting).

The default setting, VOX 4, corresponds to a -28dBm signal (anything over this level triggers recording).
The highest setting, VOX 6 (high signal / low sensitivity), corresponds to a -20dBm signal. Channels set to VOX 6 will be triggered by loud conversations or signals, but quieter conversations may fail to trigger recording.

The lowest setting, VOX 1 (low signal / high sensitivity), corresponds to a -40dBm signal. Channels set to VOX 1 will be triggered by soft conversations or signals, but noisy lines may also trigger recording.

In most cases the default setting (VOX 4) is adequate.

**Off-Hook (1 - 6)**

This is the recommended setting for normal recording on PSTN telephone lines. It will cause a call recording to be automatically triggered when the phone handset is taken Off-Hook, and ended when the handset put back On-Hook. If you are recording telephone calls from analog phone lines (POTS circuits), we recommend that you use this as default trigger setting during the initial set-up.

The **Off-Hook** function is triggered by a voltage change on the line. A drop in voltage (On-Hook voltage is typically 48V DC, Off-Hook voltage is typically 8V DC), will normally provide sufficient voltage change to be detected by the recorder, and activate recording. Replacing the receiver would normally stop the recording.

Different Off-Hook settings are available to provide triggering at different voltages.

The Off-Hook voltage ranges and their corresponding Off-Hook Settings are:

- **Off-Hook #1**: Recording Trigger with Off-Hook voltage below approximately 5 volts and On-Hook is above 7 volts.
- **Off-Hook #2**: Recording Trigger with Off-Hook voltage below approximately 10 volts and On-Hook is above 12 volts.
- **Off-Hook #3**: Recording Trigger with Off-Hook voltage below approximately 14 volts and On-Hook is above 16 volts.
- **Off-Hook #4**: Recording Trigger with Off-Hook voltage below approximately 17 volts and On-Hook is above 19 volts.
- **Off-Hook #5**: Recording Trigger with Off-Hook voltage below approximately 20 volts and On-Hook is above 22 volts.
- **Off-Hook #6**: Recording Trigger with Off-Hook voltage below approximately 25 volts and On-Hook is above 27 volts.

**Example 1:** If the On-Hook voltage is 48volts and the Off-Hook voltage is lower than 15 volts use setting Off-Hook #4.

**Example 2:** If the On-Hook voltage is 24volts and the Off-Hook voltage is lower than 3 volts use setting Off-Hook #1. If the On-Hook voltage is above the range that is set the channel will start to record.

![The Off-Hook voltage ranges may vary slightly due to phone line conditions and component tolerance. Off-Hook #4 would be the recommended setting for most standard phone line recording applications. If the phone line does not have DC voltages that can be]
sensed by the recorder for start/stop recording so that an off-hook setting does not work satisfactorily, the VOX trigger should be used instead. Each channel can be individually set as is best for its source of conversations. If the Off-Hook setting does not work satisfactorily, the VOX trigger should be used instead.

If a channel is set to Off-Hook and no line is connected to the channel, the channel will commence recording, which can only be stopped by setting the channel to OFF or VOX. Caller ID data (inbound number information - CID) will only be available to the recorder on channels recording directly from phone lines and with the CID data provided by your phone service provider in the Belcore standard format. Caller ID data is not available for channels recording from handset/headset audio.

Manual
This setting prepares the channel to receive manual recording instructions from an external third party applications developed in conjunction with Total Recall. Most installations do not use this setting.

Off
A channel that is set to Off is effectively deactivated and no recording is possible on that channel. It is recommended that all unused analog channels be set to Off.

28.10.2. Beep

Beep (‘pip tone’) is a beep sound generated every 15 seconds to indicate to both parties that the call is being recorded.

In some countries, it may be mandatory to play a beep tone when recording. For others, it is a matter of preference or company policy.

Total Recall does not transmit a recorded message to advise that recording is taking place.

The Beep setting determines the volume of the beep. The options are Hi, Mid, Low or Off. If not set to OFF, the beep will be active even if the channel Trigger is set to OFF.

The default Beep setting is Off.

28.10.3. Detect DTMF

Total Recall detects DTMF tones during calls on all channels. However, analog channels may be used for recording analog signals other than telephone calls, such as radio. Such signals do not carry DTMF digits, however they may contain audio frequencies that resemble DTMF tones, which Total Recall will incorrectly interpret as DTMF.

Set Detect DTMF to On to enable DTMF detections on channels used to record telephone calls, and to Off for channels that are used for signal sources that do not contain DTMF.
28.10.4. Extension

For all analog recording where there is no calling or called number signaling on the line, it is advisable to set an extension value for each connected channel.

Setting an Extension value for a channel means that:

- Calls (or other recordings) on that channel can be searched for by extension value.
- Extension specific recording policies can be created.
- Extension specific venting policies can be created.

Where an analog channel is used for recording telephone calls, any extension information in the call signaling on the line will override the extension value set for that channel.

To set Analog Channel Settings:

1. Highlight the channel and click Edit.

The Edit Channel Settings dialog displays.

2. Select the Trigger Type for the channel.
3. Select Beep Level for the channel.
4. Set the DTMF control for the channel.
5. Set an Extension value for the channel.
6. Select OK.

Check the Apply All box to apply the Trigger Type, Beep and DTMF settings to all channels.

28.11. PBX (Optional – TR Rack Only)

Use the PBX tab to configure Total Recall to analyze SMDRs from the PBX, which is used to capture extension-side information. The PBX tab contains the following configuration tabs:

- CDR Collector.
- CDR Parser.
28.11.1. **CDR Collector**

Use the **CDR Collector** tab to configure the connection to the PBX.

28.11.2. **Collector Type**

The Collector Type is the method by which **Total Recall** is connected to the PBX.

Options are:
- UDP.
- TCP Server (PBX initiates connection).
- TCP Client (**Total Recall** initiates connection).

28.11.3. **UDP/TCP**

With UDP or TCP (client or server) selected, the following parameters must be supplied:
- **Port**
  
  This is the UDP or TCP port that will be used for IP communication between the PBX and the **Total Recall**.

- **IP Address**
  
  This is the IP address that will be used for IP communication between the PBX and the **Total Recall**.
28.11.4. Verifying the Connection

To verify that the connection has been configured correctly:

1. Select the Collector Type.
2. Enter the appropriate Port and IP Address for the administration interface.
3. Click Apply.
   A message displays to confirm that the settings are temporarily active on Total Recall.
4. Make a test call or calls. The test calls should reflect the type of calls that are normally made on your PBX, and should vary in direction (incoming / outgoing / internal).
5. Click Get Collected.
   If the settings are correct, Remote Manager retrieves the last 10 SMDR strings from the recorder and displays them in the Live Data field. Inspect the data to verify that the correct data is being collected. You should be able to recognize calling and called numbers somewhere in the strings. If you can, see Parsing the Data below.
   If the settings are incorrect, no data is displayed. Check your settings against the PBX configuration and try again.

28.11.5. CDR Parser

In order for Total Recall to make use of the SMDRs, it must be able to parse the SMDRs correctly. Use the CDR Parser tab to upload a parser.
To parse your data using a parser:

1. Click the **CDR Parser** tab.

2. In the **Select Parser** pane, select the appropriate parser for your CDR format from the drop-down **Parser** list.

3. In the **Test Parser** pane, click **Get Last String**.
   The most recently collected data string is displayed in the text field.

4. Click **Parse**.
   The table is populated with attributes and values from the data.

5. Inspect the table to confirm that the string has been parsed correctly for all attributes.
   If the table is populated correctly, the parser is working and extension information will be available for recorded calls.
   If the table is not populated correctly, you will require a custom parser.

To request a custom parser:

1. Click the **CDR Collector** tab.

2. Make a selection of test calls that reflect the type of calls that are normally made on your PBX, including:
   - An inbound call from an external number.
   - An outbound call from an internal number.
   - An internal call (extension > extension).

3. Click **Get Collected**.

4. Either:
   - Click **Save As** to create a text file, which you can email to Total Recall Support (at the pre-populated address).
     A dialog is presented before the file is saved allowing you to supply information about the test calls made.
   - Click **Email** to attach the data as a text file to a pre-addressed email (using the system default email client).
     The generated email also includes prompts to supply information about the test calls made.

On receipt of the data, Total Recall Support will endeavor to write a CDR data parser for your PBX.
28.12. **License (TR Rack Only)**

Use the **License** tab to enter new and renewed channel and feature license keys on your **Total Recall Rack**.

The hardware key for the **Total Recall** recorder is displayed as a read-only field for reference.

The VoIP and ISDN license field is not relevant to your **Total Recall Rack**.

Please note that **Total Recall Rack** cannot support VoIP or ISDN recording. Analog channels do not require a channel license key. Analog channels become active automatically when you install analog boards in the system.

The feature license key enables the following application features:

- SMDR Parsing.
- SNMP Alarm Integration.
- Network Archive.

Your system will not support and you will not be able to configure the above features without a valid feature license key.

**To enter a new Feature License Key:**

1. Click the **License** tab.
2. Enter the **Feature** License as required.
3. Click **Apply**.

<table>
<thead>
<tr>
<th>Hardware Key</th>
<th>0000 - 0000 - 0000 - 0000 - 0000 - 0000</th>
</tr>
</thead>
<tbody>
<tr>
<td>VoIP &amp; ISDN License</td>
<td>0000 - 0000 - 0000 - 0000 - 0000 - 0000</td>
</tr>
<tr>
<td>Status</td>
<td>Valid</td>
</tr>
<tr>
<td>Expiry Date</td>
<td>Never</td>
</tr>
<tr>
<td>ISDN Channels</td>
<td>0</td>
</tr>
<tr>
<td>VoIP Channels</td>
<td>0</td>
</tr>
</tbody>
</table>

| Feature License | 9999 - 9999 - 9999 - 9999 - 9999 - 9999 |
| Status | Valid |
| Expiry Date | Never |
| Extension Policies | Yes |
| Signalling Mapping | Yes |
| Internal Dial Plan | Yes |
| SMDR Parsing | Yes |
| SNMP Integration | Yes |
| Network Archive | Yes |
| RCD Agents | Yes |
28.13. SNMP (Optional, TR Rack Only)

Use the SNMP tab to enable and configure the built-in SNMP Agent. This will allow your TR Rack to interface with a third party SNMP alarming package.

28.13.1. Agent Configuration

The Agent Configuration section contains parameters that control the operation of the built-in SNMP agent.

28.13.2. IP Address

This is the IP address that the agent will use for SNMP communication. This should be the IP address of the Ethernet port which is used for remote access.

28.13.3. UDP Port

This is the UDP port that the agent will use for SNMP communication.

28.13.4. Read-only Community

This is the SNMP v1 and v2c community string which allows read only access to the MIBs on the system.

28.13.5. Read-write Community

This is the SNMP v1 and v2c community string which allows read and write access to the MIBs on the system.

To enable the SNMP agent:

1. Check the Enable SNMP box.
2. Select the IP address from the drop down box.
3. Modify the Port if necessary.
4. Specify the Read-only Community if required.
5. Specify the Read-write Community if required.
6. Click on the Apply button.
28.14. Traphosts

The Traphosts section allows you to configure SNMP traphosts which will receive events from the Total Recall.

See Trap Table on page 119 for a list of events that the traphosts will receive.

28.14.1. Traphost

This parameter specifies the remote traphost which will receive the events. The format of this parameter is:

```
[<transport>:]<ip address>[:<port>]
```

For example:

- `192.168.3.186`
  Specifies a traphost at IP address 192.168.3.186 which expects SNMP communication on port 162 via UDP.

- `tcp:192.168.3.186`
  Specifies a traphost at IP address 192.168.3.186 which expects SNMP communication on port 162 via TCP.

- `udp:192.168.3.186:162`
  Specifies a traphost at IP address 192.168.3.186 which expects SNMP communication on port 162 via UDP.

28.14.2. Community

Sets the SNMP community string for SNMP v1 and v2c transactions; in this case traps.

28.14.3. Trap Type

One of:

1. SNMP v1 Trap
2. SNMP v2c Trap
3. SNMP v2c Inform

To add a traphost:

1. Click on the Add button.

The Traphost Configuration dialog displays:
2. Enter the Traphost service access point for SNMP transactions.

3. Optionally, specify the Community for SNMP v1 and v2c transactions with the traphost.

4. Select the Trap Type.

5. Click on the OK button. This will take you back to the SNMP tab where you must click on the Apply button to add new traphost to the configuration of the SNMP agent.

29. System Maintenance

Right clicking on a connected unit in the TR Tree will open a menu allowing you to view important information about the unit, as well to perform authorized system functions.

System Maintenance options are only available when logged in to Remote Manager with an Administrator account.

29.1. System Maintenance Options

29.1.1. System Information

The System Information screen displays useful system information:

- **Software Revision** – The current software revision on the Total Recall unit.
• **Analog Channels** – The number of analog channels currently installed on the **Total Recall** unit.

• **VoIP & ISDN Channels** – This is not relevant to your **Total Recall Desktop** or **Rack** unit.

• **Recorder ID** – The currently assigned Recorder ID.

• **Stored Calls** – The number of individual calls currently on the call database.

• **Disk Space Used** – The percentage of **Total Recalls** onboard storage that is currently used.

• **Archive Device** – The current default archive device.

None of this information is user editable.

### 29.1.2. Archive

‘Archiving’ copies call files from the onboard system storage to another storage media, such as DVD/CD or (optionally on **TR Rack**) to a network location, for greater portability or long-term storage.

Calls may be archived according to certain parameters. These parameters are:

• **All Calls** – Every call on the internal database.

• **Found Calls** – The calls found in the most recent database search.

• **Unarchived Calls** – Calls that have not yet been archived to a location other than Total Recall’s onboard storage.

• **Tagged** – Calls that have been manually ‘tagged’ by users.

> Please note that manually archived calls will **not** be included in any scheduled **Automatic Archives**.
To archive calls:

1. Select Archive Calls by right clicking on a current Total Recall unit in the left hand menu.

2. Select which calls to archive via the drop down menu. Choose to archive All Calls, Found Calls, Unarchived Calls or Tagged Calls.

3. Choose which location you would like to archive to. Select from DVD/CD media or Network Location (optional on TR Rack, if configured).

4. Select OK.

29.1.3. Rebuild TR Database

This option allows you to rebuild the call database on your Total Recall unit. A database rebuild is recommended where the system has been subjected to an improper shutdown.

Please note that recording will stop while the system is rebuilding the database.

29.1.4. Update TR Software

This option allows you to install an updated version of Total Recall software on your system. You need a Total Recall Application CD to upgrade the software on the system.

To upgrade your Total Recall Software:

1. Insert the Total Recall Application CD in the CD/DVD drive on the PC which runs Remote Manager.

2. Select Upgrade TR Software via right clicking on a current Total Recall unit in the left hand menu.

3. Select the Total Recall Application package (.tgz format) on the application CD as shown on the following screen capture:

4. Click on the Open button, then follow the screen prompts to complete the upgrade.
Note that the **Total Recall** system will automatically reboot itself during the upgrade process. Recording does not continue during the upgrade process and while the system is rebooting, which may take up to 5 minutes to complete.

The upgrade function only affects application and operating system files. However as an extra precaution, it is recommended that you back up all important calls from the call database before you perform an upgrade.

Your passwords and system settings are not affected by updating the system software.

### 29.1.5. Load TR Settings

This option allows you to restore the **Total Recall** system configuration from a file that is stored on the hard drive of your **Remote Manager** PC.

**To load TR Settings from a saved configuration file**

1. Select **Load TR Settings** by right clicking the **Total Recall** unit in the Device Tree.
2. Navigate to a previously saved configuration file on your hard drive. Click on the file, and then click **Open**.
3. Follow the on-screen prompts to load the new settings.

### 29.1.6. Save TR Settings

This option allows you to backup the current system configuration to a file that can be stored on your PC hard drive. This saved configuration can be used to restore your system to a previous configuration if required.

**To save TR Settings in a configuration file**

1. Select **Save TR Settings** by right clicking the **Total Recall** unit in the Device Tree.
2. Navigate to the folder on your hard drive where you would like to save the configuration file. Define a name for your saved configuration, then click **Save**.

### 29.1.7. Shutdown

This option allows you to remotely shutdown the system.

Note that the system will power off and recording will not continue until you restore power to the system.
30. Event Log Tab

Use the **Event Log** tab to view a record of system events for the selected recorder.

![Event Log Screen Capture](image.png)

30.1. Event Types

The Event Log may contain 3 types of event:

- **Information**
  - Information events are standard system events and do not require any further action.

- **Warnings**
  - Warnings are events that may indicate possible future problems, and should be investigated – for example, failed database searches and power failures.

- **Errors**
  - Errors are events that must be investigated immediately, such as database rebuild failures, auto-archive failures, and DSP card issues.

30.2. Using the Event Log

To filter the displayed entries in the Event Log, click the button for the event type that you wish to view.

To refresh the Event Log, click ![Refresh Button](image.png).

The Event Log can hold approximately 100,000 entries. When the Event Log is full, new entries automatically overwrite old entries.

The contents of the Event Log can be selected and copied out into a text editor to allow keyword searches.
31. Connecting Through Firewalls

Due to the virtually infinite number of possible network configurations it is impossible to document installation solutions for all eventualities.

However, the examples below should provide an idea of the principles behind configuring a Total Recall recorder for remote access via a firewall.

The main points to bear in mind are:
- The recorder must be assigned a hostname using Remote Manager via a direct connection before it can be accessed via a firewall.
- Port forwarding must be done at the firewall to allow audio data through.

31.1. Example 1: Internal Recorder, External PC

In the following example, the Total Recall recorder is installed on an internal network with an IP address range of 192.168.3.0/24.

The recorder has been assigned the address 192.168.3.109 to the LAN 1 Ethernet Port.

There is a firewall in place to provide secure access between the internal network and the internet.

The firewall’s public (WAN) address is 203.10.10.10, and the internal (LAN) address is 192.168.3.252.

PCs on the internal network are able to access the recorder directly via its IP address across the LAN.

A client would like to be able to connect to the recorder over the internet and through the firewall from home.

Figure 8 - Remote access - Total Recall behind firewall

To configure the above example network to allow remote access through the firewall:

1. On the Total Recall recorder, open Network Settings and set the Default Gateway for the LAN 1 Ethernet Port to the firewall’s internal address (192.168.3.252).
2. Install **Remote Manager** on an internal network PC.

3. Add the **Total Recall** recorder to the **Remote Manager** settings.

4. Use **Remote Manager** to assign a host name to the recorder, for example `totalrecall1`.

5. On the firewall, forward ports **10010** and **10011** to the recorder’s IP address (192.168.3.109), and port forward FTP (port 21) if you want to email calls or save calls to local folders.

   The above assumes that the **IP Address** and **Base Port** in the Remote Manager settings have been set 192.168.3.109 and 10010.

6. Configure the external PC to resolve the hostname `totalrecall1` to the firewall’s public IP address (203.10.10.10).

   You can do this by editing the hosts file. For example, on Windows 2000 or XP, open the file: `c:\windows\system32\drivers\etc\hosts`, and add the following line:

   ```
   203.10.10.10 totalrecall1
   ```

   To verify that the hostname is being resolved properly, try pinging the recorder.

7. Install **Remote Manager** on the external PC.

8. Add the **Total Recall** recorder to the **Remote Manager**, using the hostname instead of the IP address.

   The internal recorder should now be visible from the external PC.

### 31.2. Example 2: External Recorder, Internal PC

In the following example, the situation is reversed - the **Remote Manager** client PC is on an internal IP address, trying to access a **Total Recall** recorder which is external to the LAN.
To configure the above example network to allow remote access through the firewall:

This process assumes you have already assigned a hostname to the recorder. See Example 1.

1. On the firewall, port forward **UDP** from ports **10001** and **10002** to the IP address of the PC running **Remote Manager** (192.168.0.1).

2. Install **Remote Manager** on the PC.

3. Add the **Total Recall** recorder to the **Remote Manager** settings using the hostname instead of the IP address.

4. Check the **Manager Firewall** check box, and enter the external IP address of the firewall (203.217.22.165) in the associated field.

The external recorder should now be visible from the internal PC.

### 31.3. Example 3: Multiple Remote Manager Clients Behind a Firewall

The following example is similar to the previous one, but with two **Remote Manager** clients PCs behind a firewall, trying to access a **Total Recall** recorder which is external to the LAN.

![Figure 10 - Remote access - Total Recall behind a firewall, 2 Remote Manager PCs](image-url)
To configure the above example network to allow remote access through the firewall:

1. Configure the first PC as in the above example:
   On the firewall, port forward **UDP** from ports 10001 and 10002 to the IP address of the PC running Remote Manager (192.168.0.1).

2. Install **Remote Manager**, add the recorder (using the hostname instead of the IP address) with **Manager Firewall** checked, and the firewall’s external IP address supplied.

3. Install and configure **Remote Manager** on the second PC identically to the first, but assign port 10005 as its base port (**File** menu > **Advanced**).

4. On the firewall, port forward **UDP** from ports 10005 and 10006 to the IP address of the second PC (192.168.0.2).
   The external recorder should now be visible from both internal PCs.

5. Repeat the process for any further PCs, using different port pairs each time.

### 31.4. Limitations of Firewalled Connections

#### 31.4.1. Transfer of Files

Transfer of files is done using the FTP protocol, on its default port (21). If two recorders are behind the same firewall, it is not possible to port forward FTP to both machines. The user will only be able to transfer files from the recorder which is receiving FTP.

If this limitation is unacceptable, alternatives are using a VPN, or screen-sharing technology (such as Microsoft’s Remote Desktop Connection).
Record on Demand

32. Introduction

Record on Demand (ROD) is an optional Windows®-compatible client application that provides additional real-time recording control to Total Recall end users (usually agents). Record on Demand is supplied on CD free-of-charge with all Total Recall systems, for installation and use on as many PCs as required.

Utilizing an existing LAN connection, users can start and stop the recording of current calls, control which calls on their line are recorded and which aren’t, and add notes to current calls – all from a simple taskbar application on the user’s PC.

If a user requires ROD functionality but does not have immediate access to a PC, recording can also be controlled by the use of configurable codes entered on a user’s phone.

ROD functionality is configured (either as a ‘global’ setting across all extensions, or on an individual extension basis) on the Total Recall unit itself, or in Remote Manager.

See ROD Agents in Section 28.7. for information about using Remote Manager to add and manage ROD users.

33. System Requirements

Minimum system requirements for ROD are:

- Multimedia PC running Windows 2000/XP/Vista32/Vista64
- 100Mb free HDD space
- 256Mb RAM
- Display resolution 800x600, 256 colors
- LAN device or modem

ROD agents are added and managed using Remote Manager, which must be installed and operational before ROD can be used.

34. Installation

It is recommended that the system administrator perform the initial installation and configuration.

ROD Software is supplied on a CD together with Total Recall.
To install, insert the CD into the user’s PC DVD/CD drive, and follow the onscreen instructions. If the install does not start automatically, manually run `setup.exe` from the disc.

Please check with your system administrator before installing ROD.

---

Do not insert the CD into the Total Recall DVD/CD drive – ROD is Windows PC software only.

## 35. Configuration

### 35.1. Running ROD for the First Time

To start ROD, double-click the desktop shortcut, or select TR Record on Demand from the Start menu.

The first time ROD is run, the Configuration dialog displays.

#### 35.1.1. Configuration Dialog

![Configuration Dialog](image)

Use the Configuration dialog to supply Total Recall connection details, and to set the extension on which the user will have recording control.

#### 35.1.2. IP Address

Enter the IP address of the recorder on which the user will have recording control. The IP address used for ROD communication is usually that of LAN 1.

#### 35.1.3. Total Recall Extension

Enter the extension on which you want the user to have recording control.

This could be their own extension, or someone else’s extension (for example, if they are monitoring calls using Remote Manager).

You may use a mapped value or a raw (unmapped) value when defining the extension over which ROD will have control; however you must ensure that
Extension values and the Internal Dial plan have first been configured on the Total Recall unit.

- See especially sections 28.9 and 28.10.4 of this manual for further information.

### 35.1.4. Total Recall Password

Enter a user or administrator password for the Total Recall recorder. This is not the user (agent) password, but rather the password that you would use to access the Total Recall system via the control panel.

### 35.1.5. Total Recall Port Base

Enter the port base for the recorder. This can be left at the default value (10010) unless it has been changed on the recorder.

### 35.1.6. Version

This is the ROD software version (read-only).

This must match the Remote Manager software version in order for ROD to function properly.

- These settings can be modified at any time by the user, by clicking the Configuration button on the ROD main dialog.

When you have supplied the necessary information, click OK.

### 35.2. ROD Agents

ROD agents must be configured via Remote Manager settings before they can use ROD to connect to a Total Recall and control recording on their extension.

- See ROD Agents on page 92 for further information.

### 35.3. Recording Control

The level of recording control that the user has on the configured extension is determined by the ROD Mode Extension Settings on the recorder, which can be set either directly, or remotely from Remote Manager.

- See Extensions on page 78 for information about setting ROD Mode options using Remote Manager.
SNMP Traps

36. Event Types

The Total Recall can generate 3 types of events as SNMP v1 and v2c traps to SNMP traphosts:

- **Information**
  
  Information events are standard system events and do not require any further action.

- **Warnings**
  
  Warnings are events that may indicate possible future problems, and should be investigated – for example, failure to archive and power failures.

- **Errors**

  Errors are events that must be investigated immediately, such as database rebuild failures and hardware issues.

The TOTALRECALL-MIB contains the SNMP object identifiers (OIDs) for all traps. In general the root of all trap OIDs is “TOTALRECALL-MIB::trNotifications” or .1.3.6.1.4.1.29585.1.1.0

In addition to the traps that are defined in the TOTALRECALL-MIB, the Total Recall SNMP Agent generates a SNMPv2-MIB::coldStart trap on start-up and a NET-SNMP-AGENT-MIB:nsNotifyShutdown on shutdown.

See SNMP on page 104 for further information.
### 37. Trap Table

<table>
<thead>
<tr>
<th>Trap</th>
<th>Type</th>
<th>Description</th>
<th>Suggested Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECORDER_INIT</td>
<td>anggan</td>
<td>The system is initializing and preparing for normal operation.</td>
<td></td>
</tr>
<tr>
<td>RECORDER_FINI</td>
<td>anggan</td>
<td>The system is shutting down. Recording ceased and the system is preparing to power down.</td>
<td></td>
</tr>
<tr>
<td>START_RECORDING</td>
<td>anggan</td>
<td>The system is now recording calls.</td>
<td></td>
</tr>
<tr>
<td>STOP_RECORDING</td>
<td>anggan</td>
<td>The system stopped recording. This can be due a recovery operation (such as database rebuilding) or due to recording period configuration.</td>
<td></td>
</tr>
<tr>
<td>PURGING_STALE</td>
<td>anggan</td>
<td>The system is removing recordings, which are older than the lifetime specified in the configuration, to free disk and/or database space.</td>
<td></td>
</tr>
<tr>
<td>PURGING_ARCHIVED</td>
<td>anggan</td>
<td>The system is removing recordings, which have been archived in the past, to free disk and/or database space.</td>
<td></td>
</tr>
<tr>
<td>PURGING_UNARCHIVED</td>
<td>!important</td>
<td>The system is removing recordings, which have NOT been archived in the past, to free disk and/or database space.</td>
<td>If necessary, review your archiving strategy and adjust the archiving time period.</td>
</tr>
<tr>
<td>QUICK_REBUILD</td>
<td>!important</td>
<td>The system is performing a quick check of the database after a dirty shutdown.</td>
<td>Wait for the activity to complete. If normal activity does not commence after the check, attempt a full rebuild of the database.</td>
</tr>
<tr>
<td>FULL_REBUILD</td>
<td>!important</td>
<td>The system is rebuilding its database. This activity may take some time. Recording is not possible while the activity is in progress.</td>
<td>Wait for the activity to complete. If normal operation does not commence after the rebuild, you may need to replace the hard disk.</td>
</tr>
<tr>
<td>DB_CORRUPT</td>
<td>✗</td>
<td>The system database is corrupt or in a state which prevents normal operation.</td>
<td>Attempt a full rebuild of the database. If that fails, you may need to service the system.</td>
</tr>
<tr>
<td>START_ARCHIVE</td>
<td>anggan</td>
<td>The system started a new archiving session.</td>
<td></td>
</tr>
<tr>
<td>STOP_ARCHIVE</td>
<td>anggan</td>
<td>The system completed an archiving session.</td>
<td></td>
</tr>
<tr>
<td>ARCHIVE_REMINDER</td>
<td>!important</td>
<td>The hard disk occupancy has reached a level (set in the system configuration) which triggers a reminder to archive recordings.</td>
<td>Perform a manual archive.</td>
</tr>
<tr>
<td>MEDIA_FULL</td>
<td>!important</td>
<td>The system attempted to archive recordings onto a DVD/CD, however the DVD/CD in the drive is full.</td>
<td>Insert a new DVD/CD in the drive.</td>
</tr>
<tr>
<td>Trap</td>
<td>Type</td>
<td>Description</td>
<td>Suggested Action</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MEDIA_BAD</td>
<td>!</td>
<td>The system attempted to archive recordings onto a DVD/CD; however, it detected an unsupported media or media that has problems.</td>
<td>Replace the DVD/CD with a new one.</td>
</tr>
<tr>
<td>SHARE_FULL</td>
<td>!</td>
<td>The system attempted to archive recordings onto a Network Share; however, it found that there is no free disk space on the share.</td>
<td>Free up space on the share, or configure a new share.</td>
</tr>
<tr>
<td>SHARE_ACCESS</td>
<td>!</td>
<td>The system attempted to archive recordings onto a Network Share; however, it found that can not connect to the share, or it can not write to the share.</td>
<td>Check the configuration on the system and the share. Make sure that the share allows the system write access.</td>
</tr>
<tr>
<td>FILTER_REMINDER</td>
<td>!</td>
<td>It is time to clean or replace the air intake filter.</td>
<td>Clean or replace the air filter to prevent overheating.</td>
</tr>
<tr>
<td>LICENSE_EXPIRED</td>
<td>!</td>
<td>The channel license has expired.</td>
<td>Renew your channel license.</td>
</tr>
<tr>
<td>NO_CHANNEL</td>
<td>!</td>
<td>The system is not able to record a call because all recorder channels are busy.</td>
<td>Review the channel capacity and/or purchase a license for more channels.</td>
</tr>
<tr>
<td>LONG_CALL</td>
<td>!</td>
<td>The system stopped recording a call because it exceeded the maximum call duration specified in the configuration.</td>
<td>Increase the maximum call duration and/or make sure that there are no networking problems which prevent the recorder from “seeing” all signaling messages.</td>
</tr>
<tr>
<td>CALL_START</td>
<td>📞</td>
<td>Call started on the specified extension. The trap carries the extension number in the TOTALRECALL-MIB::trObject::trNoticeArgs element.</td>
<td></td>
</tr>
<tr>
<td>CALL_END</td>
<td>📞</td>
<td>Call ended on the specified extension. The trap carries the extension number in the TOTALRECALL-MIB::trObject::trNoticeArgs element.</td>
<td></td>
</tr>
<tr>
<td>QUIET_EXTENSION</td>
<td>!</td>
<td>The system detected lack of activity (new calls) on the specified extension for a configured period of time. The trap carries the extension number in the TOTALRECALL-MIB::trObject::trNoticeArgs element.</td>
<td>Investigate the reasons for the quiet extension, as required by your internal dialing policies.</td>
</tr>
</tbody>
</table>
Glossary

**CLI: Calling Line Identification**

A telephony intelligent network service that transmits the caller's telephone number and in some places the caller's name to the called party's telephone equipment during the ringing signal or when the call is being set up but before the call is answered.

**CDR: Call Detail Record**

Also called Call Detail Recording or SMDR (Station Message Detail Recording), CDR is a record containing information about recent system usage, including the identities of sources (points of origin), the identities of destinations (endpoints), and the duration of each call.

**D/A: Digital to Analog**

A digital-to-analog converter (DAC or D-to-A) is a device for converting a digital (usually binary) code to an analog signal (current, voltage or electric charge).

**DSP: Digital Signal Processor**

A specialized microprocessor designed specifically for digital signal processing, generally in real-time computing.

**DTMF: Dual-Tone Multi-Frequency**

Used for telephone signaling over the line in the voice-frequency band to the call switching center. The version of DTMF used for telephone tone dialing is known by the trademarked term Touch-Tone, and is standardized by ITU-T Recommendation Q.23. Other multi-frequency systems are used for signaling internal to the telephone network.

**FTP: File Transfer Protocol**

A commonly used protocol for exchanging files over any network that supports the TCP/IP protocol (such as the Internet or an intranet).

**IDF: Intermediate Distribution Frame**

A frame that (a) cross-connects the user cable media to individual user line circuits and (b) may serve as a distribution point for multi-pair cables from the main distribution frame (MDF) or combined distribution frame (CDF) to individual cables connected to equipment in areas remote from these frames.

**IP: Internet Protocol**

A data-oriented protocol used for communicating data across a packet-switched internetwork.

IP is a network layer protocol in the internet protocol suite and is encapsulated in a data link layer protocol (e.g., Ethernet). As a lower layer
IP provides the service of communicable unique global addressing amongst computers.

**LAN: Local Area Network**
A computer network covering a small geographic area, like a home, office, or group of buildings.

**LCD: Liquid Crystal Display**
A thin, flat display device made up of any number of color or monochrome pixels arrayed in front of a light source or reflector.

**MDF: Main Distribution Frame**
A signal distribution frame for connecting equipment (inside plant) to cables and subscriber carrier equipment (outside plant).

**NTP: Network Time Protocol**
A protocol for synchronizing the clocks of computer systems over packet-switched, variable-latency data networks. NTP uses UDP port 123 as its transport layer. It is designed particularly to resist the effects of variable latency (Jitter).

**PBX: Private Branch Exchange**
Also called Private Business eXchange, or PABX (Private Automatic Branch eXchange), a PBX is a telephone exchange that serves a particular business or office, as opposed to one a common carrier or telephone company operates for many businesses or for the general public.

**PSTN: Public Switched Telephone Network**
The network of the world's public circuit-switched telephone networks.

**QoS: Quality of Service**
Control mechanisms that can provide different priority to different users or data flows, or guarantee a certain level of performance to a data flow in accordance with requests from the application program.

**SMDR: Station Message Detail Record**
SMDR is a record containing information about recent system usage, including the identities of sources (points of origin), the identities of destinations (endpoints), and the duration of each call.

**TCP: Transmission Control Protocol**
One of the core protocols of the Internet protocol suite, often simply referred to as TCP/IP. Using TCP, applications on networked hosts can create connections to one another, over which they can exchange streams of data using Stream Sockets.
UDP: User Datagram Protocol

User Datagram Protocol (UDP) is one of the core protocols of the Internet protocol suite. Using UDP, programs on networked computers can send short messages sometimes known as datagrams (using Datagram Sockets) to one another. UDP is sometimes called the Universal Datagram Protocol.

UPS: Uninterruptible Power Supply

A device which maintains a continuous supply of electric power to connected equipment by supplying power from a separate source when utility power is not available.

VLAN: Virtual LAN

A method of creating independent logical networks within a physical network.

VOX: Voice Operated Switch

A vox or voice operated switch is a switch that operates when sound over a certain threshold is detected.

WAN: Wide Area Network

A computer network that covers a broad area (i.e., any network whose communications links cross metropolitan, regional, or national boundaries). Or, informally, a network that uses routers and public communications links.

Definitions courtesy of Wikipedia
Specifications

Physical Specifications

6 Kg, 175 (H) x 370 (W) x 365 (D) mm (Desktop).
10 Kg, 220 (H) x 450 (W) x 230 (D) mm, 5 RU (Rack).

0°C - 60°C Operating & storage temperature, non-condensing.

Power

Single auto-sensing 100-240 VAC, 50-60 Hz, 180W Max PSU (Desktop & Rack).

Optional Dual Hot-Swap 110-240VAC, 50-60Hz, 300W Max PSU (Rack).

Maximum power draw for Total Recall Desktop & Rack is 80W.

Telephony Interface

Analog 2-Wire POTS, FSKR, DTMF.

Voice Processing

HQVQ (8:1) Compression. WAV (16 bit, 8 KHz) & MP3 Export.

Onboard Storage Capacity

Most recent 350,000 calls, or 60,000 hours of recordings, whichever is reached first.

Channel Capacity

4 to 24 Simultaneous Channels (Desktop).
4 to 72 Simultaneous Channels (Rack).

Recording Trigger

Off-Hook (6 different voltage levels), VOX (6 different volume levels), On-Demand (via DTMF code or PC Software).

Call Monitoring

Real-time monitoring via onboard speaker & control panel, or via Remote Manager and LAN/WAN/VPN/56k Dialup connection.

Search & Replay Controls

Via onboard speaker & control panel, or via Remote Manager embedded player & PC speakers. Start, stop, fast-forward, rewind & pause controls.

Archive Media


Network Attached Storage (NFS v2/3, CIFS/SMB) optional on TR Rack only.

Networking

One 100Mb Ethernet port, Single RS232 port (for modem connection). Network Time Synchronization via NTP.

Optional TCP/IP Alarms via SNMP, and Call Detail Record interface (TR Rack).
Limited Products Warranty

38. ComsecTR Limited Products Warranty

38.1. Our Standard Limited Warranty Period

ComsecTR warrants that Total Recall (the “Products”) conforms in all material respects to the end user documentation provided with the Products, and that the hardware components of the Products will be free from defects in materials and workmanship for a period of **13 months after the system has been shipped from the ComsecTR manufacturing facility.**

38.2. Exception for Sales Arising From Stock-Carrying Distributors/Dealers

On average, Total Recall systems are installed within 1 month of being shipped from the factory, providing end users with a minimum of 12 months warranty coverage. However, as some ComsecTR resellers carry stock this may not always be the case.

In situations where a Total Recall system has been purchased from a stock-carrying Reseller or Distributor, ComsecTR warrants that Total Recall (the “Products”) conforms in all material respects to the end user documentation provided with the Products, and that the hardware components of the Products will be free from defects in materials and workmanship for a period of **12 months after the system has been shipped from the stock-carrying Reseller or Distributor.**

Please confirm your applicable limited warranty period with the company from which you purchased the Total Recall system. ComsecTR will assume that the period set out in section 38.1. of this limited product warranty applies unless demonstrated otherwise.

38.3. Limitations of This Warranty

This limited warranty does not cover the results of accidents (including unusual physical or electrical stress), abuse, neglect, vandalism, acts of God, usage contrary to handling or operating instructions supplied by ComsecTR or repair or modification by anyone other than ComsecTR or an expressly authorized Total Recall service agent.

38.4. Handling of Faulty Parts

Please note that any faulty components replaced under the terms of this product warranty must be kept by the authorized servicing agent for verification, up to a maximum period of 12 months. If the servicing agent is unable to provide the faulty parts for which warranty replacements have been
provided, then the servicing agent will be required to pay to ComsecTR the value of the replacement parts, as determined by ComsecTR.

### 38.5. ComsecTR Record Keeping

Please note that all Total Recall serial numbers, and the serial numbers of internal components will be logged by ComsecTR, effective the date of shipment. The serial numbers of any replacement parts will also be logged by ComsecTR.

### 39. Warranty Claims and Procedure

#### 39.1. Who to Contact

If there is reason to believe that Products do not conform to the warranty set forth in Section 38.1., the affected party should notify the company from which the Product was purchased in writing of such non-conformance, no later than ten (10) days after the end of the Warranty Period for those Products, and shall provide the following details:

1. The serial number of the affected unit(s), and;
2. Details of the non-conformance, with as much specific detail as possible.

Additional details of the non-conformance may be required as the authorized service agent or ComsecTR reasonably requests.

#### 39.2. What Procedure Will Be Followed?

The company that you purchased the system from will, if authorized, provide the required service and/or organize the required replacement parts. If not authorized to provide this service, the company that you purchased the system from will elevate your service request to an authorized service agent. The authorized service agent may elect to further elevate the problem to ComsecTR if required. This will occur in accordance with ComsecTR’s standard procedures.

The user will be required to pay for the freight to an authorized servicing agent or ComsecTR if the Products need to be returned for servicing. The authorized servicing agent or ComsecTR will pay for the freight back to the customer if the goods are deemed to fail to conform to this warranty.

#### 39.3. What Services Will Be Performed?

If Products are deemed to fail to conform to this warranty by an authorized servicing agent or ComsecTR, the sole remedy shall be, at the authorized servicing agent’s or ComsecTR’s option and expense:

1. The repair or replacement of the faulty component(s), and;

---

1 If the product(s) were purchased from ComsecTR directly, then ComsecTR would be the first point of contact. However, if the product(s) were purchased via an intermediary company, then your first point of contact would be that intermediary company.
2. Return of the Products within fourteen (14) days after the authorized servicing agent receives the non-conforming Total Recall system. If the system needs to be returned to ComsecTR, an additional period of 14 days from the receipt of the unit at ComsecTR will be applicable.

*Please Note:* If ComsecTR or the Authorized Servicing Agent determines that returned Products do conform to this warranty, then the Products will be returned at the requesting party's expense and risk.

### 39.4. Important Notice: Sole & Exclusive Remedy

NOTWITHSTANDING ANYTHING IN THIS AGREEMENT TO THE CONTRARY, THE FOREGOING IS THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY BY COMSEC TR WITH RESPECT TO THE PRODUCTS.

### 39.5. Disclaimer of Warranties

#### 39.5.1. Important Notice: Disclaimer of Warranties

EXCEPT FOR THE LIMITED WARRANTY FOR THE PRODUCTS CONTAINED IN SECTION 38.1., COMSEC TR AND ITS SUPPLIERS AND SERVICING AGENTS DISCLAIM ALL WARRANTIES WITH RESPECT TO THE PRODUCTS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING AS TO PERFORMANCE, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
Legal

Total Recall requires Linux kernel and modules to operate. These come from the CentOS distribution and may be covered by the GNU General Public License (GPL) which is enclosed here for your review (as obtained from http://www.gnu.org/copyleft/gpl.html).

All Total Recall software is distributed under the Comsec TR Software License.

40. ComsecTR Software Licence

End-User Licence Agreement for ComsecTR Software.

IMPORTANT - READ CAREFULLY:

This ComsecTR Software Licence Agreement (“CSLA”) is a legal agreement between you (either an individual or a single entity) and ComsecTR Pty Ltd for the ComsecTR software product identified above, which includes computer software and associated media and printed materials, and may include “online” or electronic documentation (“SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this CSLA. If you do not agree to the terms of this CSLA, promptly return the unused SOFTWARE PRODUCT to the place from which you obtained it.

SOFTWARE PRODUCT LICENCE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

GRANT OF LICENCE

This CSLA grants you the following rights:

The software and hardware described in this document are furnished under a licence agreement and may be used only in accordance with the terms of the agreement. The software that accompanies all ComsecTR products is the property of ComsecTR Pty Ltd (ABN 40 051 658 569), and is protected by copyright law. While ComsecTR continues to own the software, you will have certain limited rights to use the software after your acceptance of this licence. Except as may be modified by a license addendum which accompanies this licence, your rights and obligations with respect to the use of this software are as follows:

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

Limitations on Reverse Engineering, Decompilation, and Disassembly: You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law not withstanding this limitation.
Termination: Without prejudice to any other rights, ComsecTR may terminate this CSLA if you fail to comply with the terms and conditions of this CSLA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.

UPGRADES

If the SOFTWARE PRODUCT is an upgrade of a ComsecTR product, you now may use that upgraded product only in accordance with this CSLA.

COPYRIGHT

All titles and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, animations, video, audio, music, text, and “applets,” incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT, are owned by ComsecTR or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES

To the maximum extent permitted by applicable law, in no event shall ComsecTR or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the software product, even if ComsecTR has been advised of the possibility of such damages.

MISCELLANEOUS

The developer, ComsecTR Pty Ltd has adopted a policy to continue the development of Total Recall, Remote Manager and Record on Demand and therefore there may be variations between the documentation and the operating system at any one time.

Should you have any questions concerning this CSLA, or if you desire to contact ComsecTR for any reason, please contact the ComsecTR reseller serving your country, or write to:

ComsecTR Pty Ltd

PO Box 572

Milsons Point, NSW 1565

Australia
41. GNU Public License

GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007


Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

PREAMBLE

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

“This License” refers to version 3 of the GNU General Public License.

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” and “recipients” may be individuals or organizations.

To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the earlier work.

A “covered work” means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available to the public, and in some countries other activities as well.

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion.


The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-source form of a work.

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code interpreter used to run it.

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.


No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ legal rights to forbid circumvention of technological measures.


You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided that you also meet all of these conditions:

a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
b) The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network server at no charge.
c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to
find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

- e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:

- a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
- b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works containing it; or
- c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the original version; or
- d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
- e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
- f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying
under this License, you may add to a covered work material governed by the terms of that license document, provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.


You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called the contributor's “contributor version”.

A contributor's “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a consequence of further modification of the contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To “grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under applicable patent law.


If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
TOTAL RECALL
Voice Logging Recorders are distributed in the U.S.A. by:

Omnicron Electronics

581 LIBERTY HIGHWAY • P.O. BOX 623 • PUTNAM, CT 06260-0623
☎ (860) 928-0377 • FAX (860) 928-6477
support@omnicronelectronics.com
www.omnicronelectronics.com